DAY 2 | FRIDAY, JUNE 157

— =
2 = by A

e

PHOTOSHO
WORLD 2018
CONFERENCE
WORKBOOK

MAY 31-JUNE 2 | ORLANDO

i
1 L]
o ; 7
) official

Sponsor

. Adobe

N //f -

e .‘;_ ; ¥
o 5 T "\._ —
#‘7

-
’ .“. = g
. :

Awestcott.
dropo

platypod
‘Bena.
@M ILLER’'S

© skvium

shutterbug

Ad.obe 2
rockynook K

COREL

i kelbyone @

Paachpit

SEE IMPOSSIBLE



<< Photoshop\/\orld

The Secrets to Creating the Best Dog Photos

a kelbyone I conference

With KAYLEE GREER

Kaylee Greer
Pet Photographer, Educator and Dog Whisperer

Kaylee Greer is an internationally recognized private and commercial pet photographer. She is
living out her dream through a camera lens in gorgeous Boston, Massachusetts. She’s traveled
the world teaching pet photography workshops and has seen her work published in many major
industry editorial titles. Her images grace calendar lines, greeting cards, products, packaging and

advertising campaigns throughout the commercial pet industry. Her photographic style is drawn directly from the
inspiration she finds inside the soul of a dog. She is fueled by the joy, whimsy and unrelenting happiness that is so
uniquely canine. Kaylee is known for her love of vibrant colors and unique process of capturing the comedy and
character of dogs. Through her business, Dog Breath Photography, it is one of Kaylee’s strongest passions to give
a voice to the voiceless by volunteering her time to local shelters and photographing the abandoned and home-
less animals who lie in wait for a second chance.

Why Dogs?

Why is it so important to capture the tiny moments that preserve the legacies of

our best friends?

Speaking Dog: The Importance Dog Body Language

How to read and interpret
canine body language for a
successful photo shoot:

Because you know your own
dog very well and he’s become
comfortable with you and your
energy, it’s possible that you
may not notice many of these
signs with him. However, it’s
very important to know what
to look for when working with
dogs who you’re only just
meeting for the first time. The
chart below illustrates the most
common canine body language
signals that communicate fear
and aggression.

Body Language of Fear in Dogs
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Real Life Example: Close Call
What body language do you see in this image that suggests territorial aggres-
sion or discomfort in the subject?

Choosing Location

When you’re choosing a location for a photo shoot with a dog, there are going
to be factors you must consider that you may never have considered before.
When working with dogs, it’s important to get to know a little bit about their
personalities, strengths, and weaknesses before setting up your shoot and
choosing a location.

Tip: It’s helpful to begin by sending your clients a questionnaire before the
photo shoot that they can fill out about their dogs. This way, you’ll be prepared
with knowledge about the dog’s personalities, likes, dislikes, fears, etc. so you
can come equipped with the proper ammo to keep your model safe, interest-
ed, and engaged. This questionnaire will also let you about what might distract
your four-legged subject, what might most motivate them on-location, etc.
This will all be extremely valuable knowledge that will help ensure a successful
photo shoot.

Once you know more about your dog model’s personality, you'll choose a loca-
tion based on that. Unlike working with people, when you’re working with a dog,
here are some new and different distractions that you will have to consider when
choosing an ideal location:

1. Noise Level (Example: an urban location close to a freeway or areas with
heavy traffic and car noises.)
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Squirrels, birds, and other local wildlife (Certain breeds, especially hunting
breeds like terriers and certain hounds will naturally be very, very distracted
by animals that they consider small prey. It’s almost impossible to keep their
attention when their primal hunting or ratting instincts kick in. So best to
avoid areas with heavy natural wildlife population.)

Foot Traffic, Bicycles, Skateboards, Rollerblades, etc

Other Dogs (Contrary to what you might think - the dog park is almost
always a very, very ineffective location for a photo shoot.)

Look for areas with ample shade/out of direct sunlight opportunities (In addi-
tion to the light of location also be aware of the temperature. Dogs tend to
overheat very quickly due to their fur coat and inability to sweat. They are far
more susceptible to heatstroke than you or | might be on a hot day. Tip: Bring
plenty of water and give extra breaks on hot days!)

While we are dog lovers, we are also artists - and that’s why, in my opinion, num-
ber 6 is the single most important factor in choosing a location.

6.

FIND SOMEWHERE BEAUTIFUL! It’s important to put in the effort to go
beyond the backyard. Make your clients aware of how rewarding it will be in
the final images to get creative with your location and seek out the perfect
backdrop for Fido on his big day. :)

Here are some examples of the very different impact that various locations can
have in the final images:
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The Importance of Warming your Four-Legged Model up to
the Camera

Click and Treat!

There’s a little trick in dog training called ‘positive reinforcement’. | utilize this
concept at each and every shoot | ever do to create a positive association in that
dog’s mind to my camera. Each time | click the shutter of the camera, | give the
dog a treat (or, for non-treat motivated dogs, another type of reward will do.)

Do not just jump immediately into snapping photos of your dog without effec-
tively warming him up to the camera first. To do so may be to cut the shoot off
before it even starts by creating a fear reaction in your dog that he just can’t
kick for as long as you have the camera out. Set yourself and your dog up for
success!

Tip: Be aware and understanding of the fact that dogs effectively ‘see’ the world
through their noses. The strongest of their five senses, dogs noses are the medi-
um through which they interpret and make sense of the world around them. To
understand how truly important a dog’s sense of smell is - take a look at this
figure: Dogs possess up to 300 million olfactory receptors in their noses, com-
pared to about 6 million in humans. And the part of a dog’s brain that is devoted
to analyzing smells is, proportionally speaking, 40 times greater than ours. What
this all means is that it’s incredibly important to let your canine subject smell
you, your bags, and (most definitely) your camera!
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Once the shoot begins, be sure to maintain an even, calm and positive energy.
Dogs feed directly off of the energy of those around them. For this reason, it’s
very important not to bring nervous, overexcited, or negative energy. It’s impera-
tive that you communicate this to your human clients as well to be sure they
arrive happy and prepared.

When | meet a dog, | feel so much joy that | think my head might pop off - all

| want to do when they walk my way is squeal with delight and roll all over the
ground with them. However, in reality - here’s what | have to do. Stand calmly,
talk to the owner, let the dogs sniff me to their heart’s content, and then slowly
make my way down to their level for a calm hello.

Camera Settings

Due to the nature of dogs and their average speed of 75 gazillion miles an hour,
it’s incredibly important that you always have your settings locked in and ready.
Unlike photographing a person, you can’t ask the animal to stand in great light
or look into your lens - he’s going to do only what he’s going to want to do and
nothing more. BE READY.

Keep your shutter speed fast

Ideally, | shoot all my natural light images at 1/1000th of a second or higher. This
is precisely because | never know when a dog is going to defy gravity next and |
need my shutter speed ready to freeze action and insatiable joy at any, unscript-
ed moment.

Here are a few examples of spontaneity in dogs and why | was so grateful to
have a fast shutter speed dialed in:
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Single Focus Point on the Eye

Keep in mind that the shape of a dog’s face is very different than a humans. A
canine snout is typically long and projects outward from their eyes. When you’re
shooting at a wide open aperture, the dog’s nose and eyes are going to be on
wildly different planes of focus. In order to nail an image, (with a few very rare
exceptions) you're going to want the eyes in focus. This is why it’s imperative
not to allow the camera to choose the focus point for you - and why you should
always set your camera to a single focus point that you manually place directly
on the eye.

Here’s an example of focus on the snout vs. focus on the eyes:

Lens Choice

m 50mm (More traditional focal length. Arguably, the most similar focal length
to the natural view of the human eye)
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m 16-35mm (Super fun wide angle! Bobbly head! A close up 16mm shot gives an
image a sense of comedy and drama)

\—\Q - ~—
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m 11-24mm (Somehow, even more extreme! Super ultra MEGA wide!)
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m 35mm (Slightly wide angle with tack sharpness right on the eyes)
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What’s in the Bag?!
Here’s what’s in the treat bag that | bring to every shoot! We’ll go over every-
thing in here and why it’s great in the next few sections!

l_ plUSh foyé rObblf l— small tennis balls

call

silent
" ~whistle

Great Tricks to Keep your Wiggly Model in Place!

m Tether leash to something (tree, bench, fence, etc.)

1
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m Tether leash to stake that screws in the ground (note: this only works for soft
ground and is less ideal for urban shoots where you’ll encounter lots of brick
and concrete.)

m Place your dog up on high object such as a rock / bench / etc. (Many dogs
will plant their feet atop a high object and will not jump down or get dis-
tracted as easily as they would if they were on the ground. It’s a great way to
keep them in place for slightly longer than if you were working directly on the
ground. Always use good judgement and make safe choices when placing a
dog on top of something.)
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m Treats! (Do note that sometimes treats are so enticing that they have the
opposite effect and actually encourage your model to move towards you to
get those glorious cookies!)

How in the World do | get a Dog to Look at Me / ‘Smile’ for the
Camera?!

Use Sounds

m Duck Call

m Kazoo

m Squeaker / Toy

m Your own voice

m Trigger Word (learn these before session starts! This might be a great ques-
tion for your questionnaire that gets sent to the client!)

m Regular or Training Whistle

It’s incredibly important not to overwhelm the dog by overusing sounds. If
sounds are used too much, you risk stressing your model out and rendering
any further sounds ineffective. (In this same vein, prepare the dog owner and
onlookers they’re planning to bring by informing them of the importance of not
overusing sounds as well.)
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Use Toys

3.*2*

Use Treats

Use the Owner

Leverage the beautiful connection that the dog has with his owner and use it
to your advantage. Often, having the dog’s owner stand behind you is a surefire
way to get him to look in your direction.

Question and Answer Time!
Use this space to write a question to ask Kaylee! Anything at all!
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With TRACY SWEENEY

Tracy Sweeney
Photographer, Educator, and Author

Tracy Sweeney, owner/photographer of Elan Studio in Bristol, Rhode Island, is an international
award-winning child, family, and commercial photographer whose work has been featured in Click
Magazine, Digital SLR Photography Magazine, Professional Photographer, Rangefinder, The UK Daily
News, Buy Buy Baby, Babies R’ Us, and Target Stores. Tracy loves capturing simple, candid moments,
the indelible beauty of new beginnings and life. She is also an educator and published author with a Masters Degree

in Education and Doctoral work in Curriculum, Instruction, and Technology. Tracy lives and works by the sea with her
husband and five children. Join Tracy, as she demonstrates how to establish connectivity and effortlessly evoke natu-

ral emotion in family photography.

With so many choices in style and approach in newborn photography, | aim to
simplify the process. | style newborns using various textures to craft natural,
sweet, and emotional images. Within my workflow, | create multiple images
within the same set to maintain efficiency and create galleries that wow clients.

One Set, Many Images

Full Body, Full Set

Position baby comfortably in full set. Layer natural textures, soft fabrics to cre-
ate interest and contrast. Wrap or swaddle the baby to keep limbs close to the
body. Use extra swaddling blankets underneath layers to help position baby,
lift head, support arms/legs etc. so that baby is comfortable and his/her body
rests peacefully.

16
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Slight Profile

Using the same set/position photograph baby from a side angle, focusing on
a slight downward profile image. Keep eye closest to you in focus and shoot
with a large aperture to soften features.

Hands
Use a Macro lens to focus on baby'’s bitty features. This image was shot with a
100mm f/2.8L Macro.
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Lips/Nose
Continue to focus on additional features within the pose. Consider alternative
angles and close-ups.

Feet/Toes
Within the same set/position, bring baby’s feet together and hold at ankle
beneath layers and focus on baby’s toes/feet.
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Half Body
Capture the same initial pose but concentrate on a half body or close up from
above. This image is very popular for birth announcements.

Seasonal

Bring seasonal elements into the studio to document the time of year (life
cyclicality). Fall example: natural or artificial elements: pine cones, leaves,
pumpkins, and apples, or with color: gold, brown, orange, and red.




Creative Newborns: Posing, Styling, and Workflow

Ph

otosho

a kelbvone

P

World

onference

With TRACY SWEENEY

However, remember one set, many images. | recognize that not everyone will
necessarily want a seasonally focused image or they do not want many. So, |
begin with the full set and then detract items for a simpler look.

Tip: Do not invest a lot of money in seasonal pieces as they are only used for a
short amount of time and trends change quickly. Find natural items outdoors
that you can incorporate (i.e. pinecones, leaves, flowers, wood, etc.)

Color
Pre-Session
Consult with your clients ahead of time in consideration of home decor, nurs-

ery, and gallery wall art complements.

Organically style the baby according to baby’s size, shape, and coloring to cre-
ate a unique, custom, hassle-free experience for your clients.

Light Neutrals
If the baby is very fair, has little to no hair, or very light hair, place a contrasting
texture between baby and white background to add depth and emphasis.

Dark Neutrals
Babies with warm coloring photograph beautifully against dark neutral back-
grounds.

20
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Begin with a neutral color wrap and then switch out for a bright color to create
an entirely different look, or add headband or hat, etc.

Tip: Purchase fabric in a yard size and cut into multiple pieces to have on hand
for additional layering, accidents, and twin duplicates.

Size, Shape & Color

Baby’s size, shape, and color should all affect your styling selections. Prior to
the session, know what colors, props, fabrics, textures, etc. you intend to use
as per the client’s request but do not commit until you meet the baby in per-
son. Allow the baby to organically inspire your selections. Whether you have

a studio or travel to your client’s home, an arsenal of wraps/fabrics in various
sizes will be beneficial. If you use headpieces, consider ones that can be sized/
manipulated easily for babies of all sizes, and/or have small clips ready to
assist in sizing. For smaller babies, use smaller items so as not to “swallow” up
the baby.

Minimalist Approach

While the majority of my newborn imagery is full of color and textures, | do
have clients who sometimes request a more minimalist approach, which omits
extraneous elements and essentially focuses on baby only.

21
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Get the Look

In styling to achieve this look, a simple wrap and fabric piece are essentially
all that is required. If you travel to clients’ homes, look for an area in the home
devoid of furnishings or photograph on mom and dad’s bed. Bring along a
neutral blanket to drape on your beanbag or cloak a chair or sofa on which
you can position baby.

Details Shots
Remember the details. I've emphasized the importance of creating one set,
many images. Within a full styling or simple set, break out a macro lens and

22
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capture the small things: fingers, toes, eyelashes, lips. Do not be afraid to fill
your full frame with one feature.

Newborns & Family

A quick note on styling parents and newborns: If parents are to be included
in images in the newborn session (which | encourage), | recommend neutral
colors and soft textures so as not to detract from the baby. Similarly, with the
inclusion of siblings, | suggest neutrals and pastels. Since | do not photograph
newborns in clothing but rather wraps/layers, | prefer to keep juxtaposing
wardrobe simple.

23
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Multiples

When photographing multiples, | apply the same session workflow as | do with
single babies, however, | am exceptionally conscientious of capturing innate
twin connectivity. In my experience as the mother of twins and in photograph-
ing many twins, they are most comfortable together, touching, feeling the
warmth of their sibling’s skin, with whom they have spent quite some time in
the womb.

Tips for positioning twins

1. Try to keep the twins in sync throughout the session. If possible, have the
feeding occur at the same time, and the soothing at the same time, and typi-
cally the babies will sleep at the same time.

2. Position one baby first and then complement baby A’s position with baby B.

3. Position the newborns close together so that they are touching and can feel
each other, which will naturally calm/soothe both babies.

4. Be aware of the placement of hands and feet to craft emotion and connectivity.

24
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With the one set, many images technique, efficiently craft multiple images
exceeding the ordinary and separate you from the competition. Pose baby
beyond the traditional beanbag. Use everyday fabrics, textures, and simple
props to create stunning portraiture and indelible memories.

25
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With DAVE BLACK

Dave Black
Photographer, Educator and Author

As a freelance photographer for over 30 years Dave’s work has primarily centered on the sports
industry for such publications as Sports lllustrated, Time, Newsweek and the award winning TV
show Sports Century on ESPN. The list of event coverage includes the Masters, Kentucky Derby,
National Football League, NASCAR and extensive work regarding the United States Olympic
Committee, Olympic athletes and coverage of twelve Olympic Games. Known for his creative use of lighting and
in particular with the artistic technique of Lightpainting, Dave’s portfolio continues to broaden into the commer-
cial and advertising industry, and with specialized lighting projects including work for the National Geographic
and their book Where Valor Rests, Arlington National Cemetery. He is one of Nikon’s “Legends Behind the Lens”
photographers and is a prominent instructor at a variety of workshops each year. His monthly website tutorial
articles “Workshop at the Ranch” attract more than 85,000 unique visitors monthly. In 2010 he released his highly
acclaimed instructional book, The Way | See It. To see Dave’s images, learn more about photography, or purchase
his book visit his website www.daveblackphotography.com.

This class is for any photographer beginner to advanced and from arm chair
QB to franchise player who wants to learn the pro techniques and strategies for
photographing SPORTS and what gear to bring to the game. So come on get
out of the dugout and join the fun and learning!

The Right Stuff is a LIVE “spin off” of my latest and most popular SPORTS class
at KelbyOne: Sports Photography: The Tools and Techniques to Get the Shot.

During this 60 minute class, | will present as many SPORTS examples/sce-
narios as humanly possible with imagery and advice. The camera settings | use
and how best to photograph each SPORT along with specific and often times
“unigue” gear that will help the photographer get the shot will be discussed.

N
R
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Here are just a few of the 20 SPORTS | plan to include in this FAST PACED class
... So pack your track shoes and hold on to your helmet because this class could
leave you breathless.

Football: With so many games and competitions being played at night under
the lights the “Work Horse” lens of SPORTS and especially Football is the
400mm f2.8.

All this being said, if you have the luxury of having good lighting, the NEW AF-S
NIKKOR 180-400mm f/4E TC1.4 FL ED VR with built-in 1.4x converter makes

a compelling argument and it’s SHARP ... $12,400 price tag and worth it. Make
sure you have a solid monopod for any large lens as no tripods are allowed on
the sidelines.

Single point AF is a great choice for Auto Focus but Group Area AF is more
forgiving if you are new to SPORTS action shooting. Auto ISO can be extremely
useful especially late in the season when players are running into the sunshine
from the deep dark shadow of the stadium ... the ISO will compensate instantly
as they break into the bright sun.

“Fill the Frame” with your marque player and try to take a knee on the sideline
to get a low angle of view at the players as it will make them look bigger and
more heroic.

Swimming: HS, College, Olympic Swimming is a LONG GLASS SPORT: 180-
400mm, 400mm, 500mm, 600mm, 800mm, and 1.4x converter ... it’s all about
the athlete’s face above the water and photographers are not very close.

27
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Your goal is to “FILL the Frame” with the athlete’s face. Use very fast shutter
speeds: 1/1000, 1/2000 (great choice), and 1/4000 (totally amazing) and freez-
es every single water droplet.

Place the Single AF point just above the middle of a horizontal frame profile to
the athlete for Freestyle and Backstroke so it clears the water and locks-on to
the athlete’s face. Breast Stroke and Butterfly can be shot profile but head-on is
usually preferred by publications.

Figure Skating: and Gymnastics ... Indoor lighting and fast action means High
ISO cameras are a must along with 70-200mm 2.8 or a 200mm f2.0 lens.

These are individual/isolated sports where the athlete(s) are not part of a team
during a game. If possible try to know some of the athlete’s program/routine
and skill placement on the ice or Gymnastics apparatus of the top competitors.
This will help you “nail” some guaranteed images.

Top competitors often have a “signature skill” that they are known for. Learn
where that skill occurs on the ice and choose your rinkside photo position to
best capture that skill.

Go up high, use REMOTE camera locations in the catwalks and shoot down.
This high angle cleans the background of any distracting elements that can
ruin a good action image. Capture the story of the athlete’s success/celebration
or defeat/fall. Slow the action down and make some artistic imagery. Shutter
speeds like: 1/30, 1/15, 1/8 can capture beautiful impressionistic imagery of
Gymnastics and Figure Skating.

28
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Adventure: Adventure and X-Game SPORTS are becoming more popular every
day. Rock Climbing, Mountain Biking, Skate Boarding, Show Boarding, Wake
Boarding, Kayaking, Surfing, and Outdoor SPORTS are fun to photograph. There
is a huge marketplace of magazines and sponsorship companies that use imag-
ery from the Adventure genre’.

A wide range of camera gear, lenses, and accessories are involved, often times
specific to the SPORT itself of which close access is awesome with short lenses
like 14-24mm 2.8, 16-35mm f4, 24-70mm f2.8.

The more familiar you are with the SPORT the more likely you are to get to
know the people involved. The more you are involved the more you are likely to
become included in the inner circle and thus, get special access and have ath-
letes do special things for you.

Adventure can include the landscape where the athlete does the SPORT. Learn
some High Speed Sync FLASH photography so you can frame the “lit” athlete in
their environment of mountains, woodlands, water, etc.

Adventure is a growing genre that will be popular for a long, long time, so get
involved with it and make some pictures.

There you go ... These 4 capsulated SPORTS examples merely scratch the
surface of what will be covered in class, so hit the gym, pump some iron, and
sprint for 1 hour with me during “The Right Stuff” a SPORTS Shooter’s Guide
at PSW 2018.

29
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Landscape Photography beyond Sticks and Stumps

With MOOSE PETERSON

Moose Peterson
Wildlife Photographer, Author and Educator

Moose’s true passion has always been and remains photographing the life history of our endangered
wildlife and wild places. Since 1981 he and his wife Sharon have dedicated their lives to this pursuit.
Educating the public about our wild heritage is their hallmark. Moose’s aviation photography has the
same goal of preserving our aviation heritage and the freedoms they protect, pictorial and oral for
future generations. Along the way Moose has been honored for his photographic passion: a Nikon Ambassador USA,
Lexar Elite Photographet, recipient of the John Muir Conservation Award, Research Associate with the Endangered
Species Recovery Program, just to name a few. He was part of Epson’s Finish Strong ad campaign. Moose was the
creative producer/photographer of his acclaimed film: Warbirds and The Men Who Flew Them. He shares his knowl-
edge through his writing, being published in over 143 magazines worldwide, author of 28 books including his latest,
Photographic FUNdamentals, Taking Flight and best seller Captured. He lectures across the country to thousands
upon thousands of photographers every year. One of the original Nikon shooters to receive the D1 in 1999, Moose
embraced this new technology, becoming the only wildlife photographer in the world to shoot strictly digital in the
early years. While a beta site for all the major hardware and software manufacturers, Moose continues being a cre-
ative innovator of new techniques both behind the camera and the computer, which is the driving force behind his
photography and goals.

“What the world needs are not more technically perfect photos; we need more
photos with passion!” | started saying that long before digital came about, but
it still holds just as true today as then. At the same time, we now have the abil-
ity at the viewfinder to know that we have the tools in the digital darkroom to
make the passion we’re feeling sing in our final photograph with a couple of
clicks in post. Our landscape images must reach out and say, “You need to be
here!” rather than “I was here.” Using light, lens and computer craft, we draw
our viewers into the magical moment we were so fortunate to experience in
person. How do we do that? Let’s explore the possibilities.
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The Experience

“Who could ever guess that so rough a wilderness should yet be so fine, so full
of good things. One seems to be in a majestic domed pavilion in which a grand
play is being acted with scenery and music and incense, all the furniture and
action so interesting we are in no danger of being called on to endure one dull
moment. God himself seems to be always doing his best here, working like a
man in a glow of enthusiasm.” John Muir

In robotic fashion with the ring of the alarm, we’re out of bed, dealing with life
and on cue, we grab the camera bag and head out the door. We drive down
the road, the headlights leading on, as the sun is only a rumor on the horizon.
We make the turn and follow a narrow road as it winds itself to the edge of our
imagination. We’re no sooner parked and we have our camera in hand, heading
like a moth to a flame towards the low glow off in the heavens. There’s a nip in
the air, your fingers tingle as you turn the camera on and put your eye to the
viewfinder. And there you see the magnificence that is the landscape you came
to immortalize. That’'s a good morning!

The reality as we all know though is that no matter how we plan, how on time
we are, no matter all the camera gear we own, things don’t always turn out in
our favor. Either Mother Nature simply doesn’t want to play or our brains turn
to mush when we’re at the camera and the most common, is a combination

of both send our good intentions out the window. Yet despite these pitfalls,
beautiful landscape images are produced to entertain us and tug at our heart-
strings, causing us to plan a trip to a far-off land to witness its majesty for our-
selves. How do YOUR photographs become the ones that do the tugging, send
others out to witness what you were fortunate enough to capture with a click?
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Most start off with things like f/stop and focal length, rules of composition and
a Photoshop recipe for the perfect post production. | want to suggest a differ-
ent concept to bring life to your landscapes. | want you to entertain the idea
that technical perfection is not what makes the great photograph. Yeah, cam-
era and computer craft are very important, don’t get me wrong, but perhaps
even more important is investing a little bit of ourselves into that click. When
we put more on the line like our heart, the more we risk, while we have more to
lose, we have more to gain. When we succeed, our reward is the simple knowl-
edge that our image brought that moment we witnessed to the hearts of oth-
ers. How do we do that?

A lone figure is astride his horse, sitting painfully straight in the saddle and
wearing the classic military cavalry uniform of the old west. His eastern man-
ner in the wide western landscape paints how painfully out of place he truly is.
Because all around him is a vast desert, in the background is the dramatic out-
line of vast towering rock, what the entire planet now mentally pictures as the
American Southwest. John Ford’s cavalry trilogy filmed in Monument Valley
even though shot in black and white, painted with vivid color the magnificent
landscape, both visually and mentally for all time and wrapped it in romance.
The challenge is simple enough, take all that you see and feel and cram it

all within the boundaries of your viewfinder. Taking our field of vision of 180
degrees, combine that with the cold snap biting at our cheeks, the clouds
floating overhead then capturing and communicating that at 1/125 of a second
with the click of the shutter is more than a simple challenge for most. Ever ask
yourself why that is? Approaching the landscape photograph as something to
conquer rather than to embrace with our cameras could be throwing up the
roadblock to your quest.
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Arranging the Elements

You need to set the stage for your landscape image by beginning the dance.
“What’s the dance,” you ask? “What’s the stage?” We need to invite the eye
into our landscapes, take it on a journey and reward it for taking the adventure.
To accomplish this, we do the tricky dance of eliminating those elements that
bar our eyes from seeing the subject while at the same time, including those
elements that tell the story about our subject. What do you include and what
do you exclude? How do you actually accomplish this?

It starts by being quite confirmed in your visual conviction of what the subject
is in your photo. In landscape photography, there is a subject and it’s more
specific than Yosemite Valley or the waves on a beach. It is the light falling

on the edge of El Capitan or the rock the waves crash around. Without that
defined subject you end up with an “l was here” photo when you want a photo
that says, “You need to be here!” Bringing that to focus in our viewfinder can
be a long-time quest, so don’t ever stop.

Setting the stage requires that you bring visual depth to your landscape. While
you stand there, it envelops you in every way, but when the viewer of your
image takes it in, all they have is a flat wall, page or screen. For the viewer of
your image to be enveloped by your image like you were by the reality, you
must, must include a foreground, middleground, and background. This is the
formula for visual depth. You can’t just have one or two, you’'ve gotta have

all three to create a visual depth in your photo. In the dance of excluding and
including elements, you want to keep this very important concept forefront in
the process.
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Where does the subject lie in this visual depth equation? It can be anywhere
though more commonly it’s in the middleground. To put it in recipe form

(and each cook should do so to taste), the foreground invites the eye into the
photo, the middleground contains the subject and the story why we should
learn more about it, and then the background finishes the story and invites the
eye back into the photo to repeat all over again. This path the eye travels must
be a simple one, easy to follow with no visual roadblocks, so the mind can liter-
ally in a second or two make sense of all that it’s being presented. That’s where
the dance comes in, to make that visual path clean and simple, excite the sens-
es and tug at the heartstrings.

It’s easy to see physical elements in the viewfinder and deal with them, but
light isn’t so easy. Too much light requires utilizing Highlight Warnings/Blinkies
with camera and computer craft to compact the exposure. An overcast day
with its flat light has the opposite problem of no light to focus the eye on the
subject. That’s the role light plays in our landscape image (along with color to
some extent), to focus our vision. We’ve all been there, we’re driving down the
road gazing out the window when we see some amazing scene out our win-
dow. We drive a little further until we can turn around, then we speed back to
the spot only to find it doesn’t have the same impact. Why is that? Normally,
it’'s some element of light that grabs our attention. The majority of the time,
the light has changed. Its play on the landscape, the elements it highlights, the
elements it hides, the combo excites our visual senses.

The rub is most of our romancing the landscape comes on ventures that are
once in a lifetime. We don’t have the luxury of parking somewhere for a year to
capture in a single click that magical moment. Yeah, we are fortunate that they
do present themselves to us at times, but that’s the exception and not the rule.
This means along with setting the stage, we’ve got to light the main characters
as well.
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We, fortunately, have many tools for this, both in camera and in post. My pref-
erence is to do as much at the time of capture, at the camera, as | can and
then only do in post what wasn’t possible at the point of capture. We have
tools as simple as exposure to change the mood of the light falling on the
scene. | often shoot at -1/2, for example, to make the shadows darker, make
the colors more saturated. | combine this at times with the split grad neutral
density filter (.9 / 3 stop soft edge) to help compact the exposure when |
have Blinkies in places in my photograph that | want visual information. This
can then migrate to combining these tools with post techniques that in many
cases you’ve got to know about, so you can set up for them at the point of
capture. This is the photographic version of what came first, the chicken or the
egg, knowing a post technique to use in the digital darkroom but when you’re
behind the camera.

You’ve got to commit!

Passion is the heartbeat of play and that’s what you’ve gotta do in this pur-
suit! If you take away only one thing from this, it’s to stop putting pressure

on yourself that every click has to be the click! | am only able to sit down and
write this information to help you by looking back at my own failures, learning
from them and moving forward. Light is a mysterious lady (or man) who we
are always seeking favors from as we propose this or that proposition to make
her (or him) look their best. Like any such advance, there are times you get
slapped in the face and other times, you score.

The mind’s eye wants to go certain places and in a certain order. Understanding

these basics of our vision greatly aids in not only how you exclude and include
elements, how you arrange the elements especially light but is the key to
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telling your visual story. There are many visual clues we can tap into to truly
manipulate the viewer’s journey through our image, but none more domineer-
ing than light and bright.

The most stereotypical example is something bright and high in the frame.
The mind’s eye can’t help but zero in on that. Knowing this simple fact, if you
have such an occurrence in your image, all you have to ask yourself is if that
is where you want the eye to go or not. Can we take that knowledge a step
further and incorporate it with the other key components I've mentioned? The
easiest way to explore that is with an image.

What attracts our eyes to a certain landscape in large part is the design of the
landscape and not the composition. If you can understand that natural, sub-
conscious attraction, you can vastly improve your landscape photographs right
from the start. Landscapes are not a composition; they are an ebb and flow of
life that creates a natural design.

| think many photographers have problems with design because it’s not spo-
ken of in nature photography and it’s being confused with composition. And
composition doesn’t help most photographers because they condense it all
down to just the rule of thirds and call it a day. To be a successful landscape
photographer, you need to get WAY passed this normal stopping point. If you
want your images to stand out from the next guy who is most likely stuck on
the rule of thirds, then you need to dig deeper and understand and implement
the principles & elements of design.
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The principles of design are considered by many as laws of design. Some may
say they are the rules you must follow to be successful, but if you know me at
all, ’'m not much for rules. I'd much rather think of them as our guidelines. We
use them as our starting point in visually commmunicating the wonders we see
before us in the wandering landscape. There are basically seven principles mak-
ing up the principles of design: contrast, emphasis, balance, unity, pattern, move-
ment and rhythm. These titles are far removed from the styles of composition
such as the rule of thirds. This is why in part I'm bringing them to your attention,
as they might relate to your photography and your style of communicating bet-
ter than the rules of composition. Let’s take a look at each of these.

Contrast is not the contrast in the photographic sense of the word of black,
gray and white tones. This type of contrast represents the differences in vari-
ous parts of the photograph. The principle is that the contrast of the elements
in the photograph is such that when they are combined they grab the interest
of the viewer of the image. A simple example would be a tree and a rock in
the same photo. A living, linear element and an inanimate, round element. A
great example | saw on the web was a marvelous romantic shot of the Coastal
Redwoods with incredible light shining through the canopy to light a trash
truck going around a curve on a wet road. Contrast is between two or more
elements in the photograph and organized to compete while residing within
the same frame. Contrasting elements can be shapes, colors, textures or even
ideology. Think about this for a moment and you’ll probably come up with your
own examples of how powerful Contrast can be in design.
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Emphasis is one of the less complicated principles to understand. It’s where
one element or group of elements in your photograph has greater emphasis
than the rest of the elements. Emphasis is created by design or organization
of elements. For example, a tranquil lake and in the lower corner is a boulder
with character, a field of green with a bed of flowers or a mountain vista that’s
dwarfed by towering thunderheads. Emphasis is one of the more common
design principles used by landscape photographers.

You actually use emphasis all the time in a very basic photographic technique
but never knew it was a principle of design. Depth of field is the most basic
of methods to emphasize an element in a photograph to create a design. The
amount of focus or the lack thereof is the mainstay of our photography and a
prime example of this principle of design.

Ever use a split graduated neutral density filter to darken a portion of your
image? Guess what, you’re actually combining a couple of elements of design
when you do that to implement principles of design. (See, not so hard, you
already have some of this under your belt!) The goal here is to recognize the
principles you know and to add to them to improve your photography.

Balance refers to an overall pattern of the elements in your photograph that
compliment or support each other. It could be so harmonious that the ele-
ments even form a pattern. An ice flow at a glacier, the rock jumble at the base
of a slope, the lift off of a flock of snow geese, these are all elements that can
arrange themselves to form a balance and pattern.
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A very commonly used balance is between earth and sky. Ever wonder why
bald skies are so unattractive to us visually? Where’s the balance? Clouds add
balance to the world, to the photograph that is completely lacking with bald
skies. Clouds not only bring balance but also color, texture, shape, and lines,
elements of design that bring further balance to the world. If you start thinking
about what might be wrong with a particular image of yours, you'd probably
find that very basic principles and elements of design are missing. Start to rec-
ognize this and guess what, you’ll start making sure to include them!

The Conversation

Unity is just as the word implies, a harmony of all the elements so one element
unites and makes the next element whole. A portrait of a tree is a prime exam-
ple of this. All the branches come together to make a form easily recogniz-
able. There is a fine line between Balance and Unity, wherein one the elements
complement each other and the other joins elements together. Personally,
while this sounds pretty straightforward, | find it hard to actually find textbook
examples of this in landscapes. An eroding hillside is the best verbal example

| can come up with. You have all these lines leading downwards and together,
they give a unity to the design, so the mind can grab hold and understand it
as a design. I've had individuals point out Unity in my images, but it’s there
strictly by accident or some subconscious means. The best example | have of it
is an image of fog ghosting its way through coastal redwoods. All the elements
are different, yet they are in unity, harmony with each other.

Pattern is the most commonly implemented design principle used by pho-
tographers because it is visually so obvious. This is a principle of design that
you’ve all used at some point in your photography. Pattern is simply the orga-
nization of elements, so your photograph has a certain patterned format.
Patterns are everywhere in nature and in landscapes, ripples in the water, fallen
autumn leaves on the ground, sand pebbles on the beach, cracked mud in the
desert, we can all name off a huge list of patterns that we’ve seen and photo-
graphed every day. And while this is the most common and well-used design
principle, keep in mind it is also the oldest and most overused principle. There
are many ways to use Pattern and make it fresh, new and very exciting. The
best example is having a killer pattern that is interrupted by a simple small ele-
ment. Now, there’s a challenge for your weekend photography, find that pat-
tern and then improve it with an unrelated element that interrupts the pattern.
Like the infamous shot of a picket fence but somewhere along the fence is the
head of a kitten peeking out, interrupting the pattern.

Movement is more the suggestion or illusion of motion rather than simply
stopping something in motion with a fast shutter speed. In still photography,
stopping the motion of a moving subject might seem like the obvious example
of movement. But it really isn’t. A better example would be a fall day with the
wind blowing, the trees swaying and leaves falling and you’re capturing this
image with a slow shutter speed so the tree and falling leaves are slightly out
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of focus. Or, using a really slow shutter speed and panning with a moving sub-
ject so the subject itself is tack sharp but the world around it is blurred. An
example you might be able to personally relate to is the blurred motion of a
creek or river. Communicating movement photographically is a challenge espe-
cially in the landscape realm when you remove water. But have you ever seen

a photograph of the Devil’'s Race Course in Death Valley? You have a flat mud
flat and carved in it is a path and at the end of that path is a boulder. Man does
that communicate movement and not only movement but a mysterious move-
ment. Too cool!

What about the suggestion of movement, what’s that all about? A bird on a
perch just about to launch into the air, that’s the suggestion of movement. One
example that most photographers have used involves anticipation as well as a
suggestion of movement, a water droplet, perhaps on the edge of a leaf just
about to go blop. Now there’s a principle of design that grabs the attention in
a heartbeat!

Rhythm is one of my favorites and it’s quite similar to Pattern with the addition
that the pattern has a beat or flow. The photograph of the Death Valley hillside
is a great visual example of this. The pattern is all the erosion going down the
ridges. The rhythm is the evenness of the erosion gullies down one ridge and
then down the next all leading to one point. While Pattern is easy to find and
photograph in the landscape, Rhythm is much more of a challenge and much
more rewarding visually when captured.

These seven principles of design depend on the seven elements of design to
make them work. The principles and elements of design all depend on other
photographic elements to bring them to life in our photographs and to excite
the viewer into oohs and aahs! Again, this is the definition of a photographer.
The seven elements of design are color, value, texture, shape, form, space and
line. Where the seven principles of design might be completely foreign to you,
I’'m sure the seven elements of design sound very familiar.

Color is something I've written a lot about and is one of the more power-

ful elements of design in my opinion! It’s where ACR excels! To say it is the
most important one might not be a total exaggeration, but close (check out
Psychology of Color at moosepeterson.com). Color, or the lack thereof, is a
very dominant way to draw the viewer into your photograph and lead them
around to see those other elements you want them to see. Color is often the
first thing that makes someone stop and take a photo or stop and look at a
photo. Color is a very important element in design and therefore commmunica-
tion! In the advertising world, color as a design element is often used to set
the mood or evoke an emotion in the viewer. Watch out, emotion is starting to
creep back into the discussion.
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Value is the relative darkness or lightness of a color (not to be confused with
hue). Color is so important that it has this second element of design. In this
case, value has to do with the dominant color being correct to communicate
the mood or emotion of the photograph. If you have a stormy landscape with
dark gray skies and you mess up the exposure so the clouds are white rather
than gray, the day in the photograph has gone from stormy to cheery. You can
almost interchange value with tone, both talking about the quality of the color
as a design element.

I’'ve actually written about this a lot, but I've always called it color contrast.
While my color contrast is not a one to one replacement of Value, it's along

the same basic lines. This is an element of design that is the backbone of the
majority of my photography. If you look at nearly all of my images you’ll find
Value in nearly everyone, being used in a multiple of ways. You owe it to your-
self to explore Value further and you do that by looking in photographs of your
own and others. Once you start seeing it there, you'll start seeing and imple-
menting it more in your viewfinder.

Texture has got to be one of my favorite design elements in photography! The
main idea is that texture will make your photograph visually more exciting than
the average photograph. When many think of texture, they think of things like
fur, feathers or bark. Texture isn’t often thought of in terms of the landscape.
But rolling hills, fields of grass, a streambed of rocks and even clouds have tex-
ture that grabs the attention of everyone.

Texture is one element of design that is very dependent on a quality of light
and color to make it apparent. The direction and quality of light are what makes
a texture visually jump off the page. A simple exercise for understanding this
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requires a carpet and flashlight. Get down on the carpet and move the flash-
light in a 360-degree circle changing how the light hits the carpet. You'd be
amazed what you might find (including the missing eyecup).

Keep in mind that texture is just an element in the photograph and rarely is it
the entire photograph. That’s because without a reference point other than the
texture itself the mind has a hard time grabbing hold of the texture and under-
standing or enjoying it.

Shape as an element of design refers to your main subject being an element
with great shape (boys, stick to landscape photography now). The unique shape
of a tree on a hillside, the shape of a flower grouping in the desert, a rainbow,
these are just a couple of unique shapes in the landscape that grab and hold our
attention. There are of course other shapes in our photograph, but the dominant
shape is that of the subject, the main element in the photograph.

Edward Weston was really good with this element of design. His images of

a pepper come crashing to mind. His ability to find naked forms in rocks is
another great example of this element of design. And while I've personally only
found one “naked form” in boulders after decades of looking, this one shape is
the most obvious example of this element of design.

Form might seem like a repeat of shape, but it is slightly different. Form has to
do with the organization of shapes in your photograph, so everything looks like
it’'s meant to go together, even if they don’t. Form is personally hard to use as

a design element by planning. That’s to say when looking through a viewfinder,
| can’t just say, “ah, there’s form, let’s use it!” It is in some of my images, but it’s
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by mistake not by design (get it, elements of design...not design). | can point
you to a great visual example of Form and that’s the imagery of my good
friend Vincent Versace. He uses it a lot and very effectively!

Probably examples most of you have seen are the photographs from the
Midwest. Rolling fields of wheat stacked behind each other with some of the
fields being harvested. This is a shape, texture and more importantly, a good
example of form.

Space is an essential element of design. Space is also many photographers’ final
frontier and I’'m being serious. The inclusion or exclusion of space in a photo-
graph makes all the difference between success and failure. There isn’t a graphic
artist out there who wouldn’t simply say, “Space has to be included in your
design.” Space means leaving areas in your photograph blank, empty, lacking
content. Often referred to as negative space, why is this so very important?

It has to do with the mind and how it works when viewing photographs,
especially for the very first time (as in, the first time it sees the photograph).
Negative space lets the human eye distinguish the elements that are meant to
be front stage and not included as part of the “background.” Space permits the
mind to have some “comfort” areas in the photograph to move to and from as it
takes in all that’s in the photograph. If anyone has ever said your photograph is
“too busy” then what he or she was also saying is you need more space.

Space is a challenge for many photographers because it requires excluding
objects in a scene. Excluding objects requires seeing them first. And there
lies the challenge. That’s because the mind sees everything but only presents
those dominant elements that for many reasons, we choose to see. Training
the mind to visually communicate everything, good and bad, so we can then
make the mental decision what to include and exclude takes time. But elimi-
nating the junk from our landscapes in order to incorporate space is essential
to success!

Line literally defines the position and direction of your photograph. You might
have leading lines taking the eye right to the subject(s), or lines outlining the
subject or lines that are borders. You can have lines that are straight, curved,

S shape or squared off. However, you have a line as a design element, you can
bet the eye will grab onto it and follow it. Line(s) are everywhere in the land-
scape. Taking advantage of them effectively so they do everything but lead the
viewer’s eye out of the photograph will make you successful as a landscape
photographer!

Just as important as having lines is not having lines that take the mind away
from the subject or out of the photograph! The mind grabs onto lines faster
than anything else. You need to use that knowledge to improve your photogra-
phy by either including or excluding them.
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Knowing all of these definitions, how does that get you closer to better land-
scape photographs? Darn good question, glad you asked! Landscapes are nor-
mally recorded with wide-angle lenses although telephotos can take a mean
landscape. In either case, there was something inspiring about the landscape
that made you stop, take note and get the camera out. As you’re setting up
the camera you look around and say to yourself, “This is gorgeous, | can’t wait
to take it!” You get all set up, put your eye to the camera and look through the
viewfinder and then you look up again. You say to yourself as you look through
the viewfinder again, “What happened to that gorgeous photograph?”

What happened is your binocular vision was turned to monocular in a heart-
beat. What happened is you moved perhaps from a roadway to a higher or
lower elevation, so the principles and elements of design changed. The breeze
in the air was replaced by the sweat on your brow. What happened is you went
from being a “tourist” to a photographer, things got serious. You were letting
the moment flow rather than trying to force it into a viewfinder.

When you look through the viewfinder you are literally forced to see the trees
from the woods and some of them might be dead. Our minds that control our
vision and report all that is being seen is a wondrous tool. Without even know-
ing it, distracting elements magically disappear, and we truly see only what we
want to see. How many times have you taken a scenic only later to discover
there is a road sign in the photograph? Didn’t see it when you took the photo,
but it was there.
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Mentally excluding unwanted elements that our minds subconsciously hide is
a huge task for the landscape photographer. Getting rid of that junk so the
viewer of our photo sees only what we want them to see is why we need the
principles and elements of design. When learned, understood and practiced
these principles permit us to “see” what the mind presents us with and elimi-
nate everything else so that’s only what our photographs contain. Without
these principles and elements, what our mind prevents us from seeing comes
crashing back in our photographs.

Furthermore, once we can see the good and the bad, we can then use these
principles so, no matter what, the viewer sees only what we the photographers
want the viewer to see. And until all of this “seeing” is very subconscious and
we just react without knowing why landscape photography is simply no fun
and very frustrating. This should not stop you though from continuing on!

Let’s look at a typical landscape photograph, the sunrise/sunset and think it
through, using the principles of design. What attracts us to the sunrise/sunset?
It’s the color, right? It’s those magnificent reds and oranges with a smattering
of yellow here and there. Who couldn’t stop and photograph it. Yet when we
look at our photograph after the fact, the great color is there, but the feeling
or mood of the sunrise/sunset is totally missing. Why?

Color is one of the elements of design. But by itself, does the Color of the
sunrise/sunset complete a principle of design? Is there Emphasis for example?
You might think so because of the color, but Emphasis is where one element
more or less dominates the photograph. If the photograph is just of the color
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of the sunrise/sunset, there are no other elements in the photograph, so the
sunrise/sunset isn’t the Emphasis. What about Contrast, Rhythm, Pattern or
Movement? Do the red and orange clouds as an element finish any of those
principles of design? They don’t, do they? So then, when you have a gorgeous
sunrise/sunset and all you photograph is the color, there is a very good reason
why the final photograph doesn’t match the reality or your memory. What ele-
ments are missing that would complete this gorgeous photograph?

Texture, Shape, Line, are those elements in your vision when you enjoy the sun-
rise/sunset, but have been eliminated in your photograph? Is there a silhouette
of trees, rolling hills, beach or lake in your vision, but not in your photograph?
Did a light just go on in your head? You might have the exact photograph |
described in your files that you’ve always wondered why it just wasn’t what
you saw or experienced. This is a perfect example of how knowing, under-
standing and implementing the principles and elements of design can vitalize
your landscape photographs. If you thought learning exposure was difficult
and took you a while, wait until you start munching on this for a while and go
out and put it into practice. Like everything photographic, it takes time so give
yourself the needed time to let it all sink in and become second nature.

The good news is that now you’ve been made aware of these principles and
elements you can start working on them. The bad news is they are only part
of the successful landscape photograph formula. Oh yes, there is more to be
learned and learned so well you can incorporate the principles and elements
of design with these other techniques. The melding of all of these techniques
of design and photography plus a whole lot more I’'m unable to list in this
Workbook. But it is what makes the great landscape photographer. But what’s
the main element taking the eye through this photograph? It's the element
that’s the most powerful tool we have in photography. Light!

| know that personally, light is the element in a landscape that attracts my atten-
tion and makes me go through hell or high water to capture the image. Without
that magic from above, while still beautiful, a landscape without light is just dirt
or grass. Light transforms the landscape from dirt to a cathedral. I'm fortunate
to live in a place that is a living landscape. Every time | walk out the front door
there is the possibility of a once in a lifetime view, because of the ever-changing
light. That’s one of the great advantages of living in the Range of Light.

Joe McNally loves to point out to photographers that, “Photography means lit-
erally to write with light” in Greek. Writing with light sounds like communicat-
ing to me. Steve McCurry takes this even further by saying, “Lighting is critical
to photography. It can make the difference between a successful picture and
just a photo. Light is at the core, the center, of photography.”

Light, as | see it in the landscape photograph, plays three major roles, working
with the principles and elements of design, creating visual depth and drama,

and most importantly evoking an emotional response from the viewer. While
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| make a distinction in writing, make no mistake that when working with light

it knows no distinction. Light falls from the heaven and on its journey, bounc-
es and is filtered, shaded and diffused, flattened and concentrated in every
form of physics described by science. It then throws in a couple extra just for
good measure. It is your job and passion as a photographer to make use of this
gift in creating your gorgeous landscape images.

“Perfect light” comes in many forms and coming across at the right moment
most certainly is luck. It can come before the sun ever rises and once the
sun has set. It can be those magical hours just after the sun appears and just
before it disappears each day. It can even happen at high noon when many
articles tell you that you should never be shooting. How do you determine
when is the right light? Back to that question again, how do you know?

There is a very emotional and technical way of answering this question.
Emotion is really simple, your heart simply says, “gorgeous!” You know what
I’'m talking about, | don’t have to spell it out or give you examples. We've all
seen it if not captured it if nowhere else than the thin emulsion of our minds. If
you don’t have an emotional response to light, then you might be in real trou-
ble and there is nothing | can suggest that might help you. The technical side
is a snap with digital. Turn on your Highlight Warning/Blinkies and if areas of
your images blink, most likely the light is not at its best. But we’re looking for
even more information here to help us.

You want to be here

Romancing light is where the emotion comes into the landscape photograph.
A viewer’s emotional response to your landscape comes from the play of light
on the scene and your play of that light in the photograph. What if you're
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emotionally challenged, how do you recognize romantic light on a landscape?
You’ve got to start looking at those photographs by known photographers that
have romantic light. Ansel Adams, Larry Ulrich, Jim Stimson are a few photog-
raphers that pop into my mind as great examples of romantic light photogra-
phers. There’s no doubt they can see it and capture it. They can also manipu-
late and print it, which is just as important as seeing and capturing it.

You can also start to recognize romantic light by realizing it just doesn’t occur
on the perfect landscape. Gorgeous light can occur over a cityscape or dump
just as easily as it can occur over the Grand Canyon or Yosemite Valley. If

you can recognize great light as it strikes the dump, then you’ll be able to
when you’re at the Grand Canyon. Light is light. If you can act on what you’ve
thought through and learned at the dump, you can do it anywhere. It’s not

a process or technique that one can learn overnight and in fact, it can take
decades. To learn and understand romantic lighting, you’ve got to see it over
and over again. Light being light, that’s simply not possible unless you live in a
locale where such lighting is the rule and not the exception. You’ve got to seek
it, stalk it and romance it to be able to see examples of it regularly!

You might be wondering if | have a “favorite” light. | do actually, two very spe-
cific types of light. My truly favorite light is right after a storm. As the clouds
begin to break up and the winds scatter them about, light dances across the
landscape in ways my mind has a hard time comprehending. As the clouds
play bumper cars in the heavens, God beams bathe the landscape like great
searchlights from the sun looking for that pot of gold to light up. This light
show ballet sends me flying, either in the truck or by foot to match up the
landscape below with the landscape above. | can think of no greater light!

The other light that | really like now that | shoot with digital are the predawn
hours, the time before the sun is just barely a hint on the horizon. This light,
which can be flat by nature, actually bounces off the heavens in a unique way.
This semi-directional light is more an element of design than the normal role
light plays in a photograph. With this type of light, color is a very important
element in the photograph. | often prefer this light type when the texture/pat-
tern is vivid in the landscape and rather than accentuate one particular portion
of the texture/pattern, | want the whole to be the emphasis.

When | think about it, there is one other light | like...flat light. | really like shoot-
ing in the rain! (Not to be confused with singing in the rain.) I'm not talking
about heavy, down pouring rain but misty to sprinkle kind of rain. This is the
type of rain where the cloud density differs, which is why you have varying
rain. This varying cloud density makes for different lighting, which is what
attracts me to getting out and shooting when it’s raining. At the same time,
the landscape itself is wet, which | like as | mentioned above. And finally, there
is often atmospheric stuff going on. A low cloud here, fog there, elements that
can add to the mystery, visual depth and romance of the landscape.
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With time, you too will come up with a list of favorite light conditions. This

in part will dictate your style of photography. It will also in part dictate the
times you get out and haunt locales, looking for that light to match up with
the landscape in your imagination. | guess that’s how I've come to capture the
landscape shots | personally enjoy. There are many spots along the normal cor-
ridors | travel that I've seen over and over again. In my mind’s eye, I've framed
up the shot a thousand times but not once have | gotten the camera out and
taken the photo. Then, one day the landscape in my imagination is lit by that
magic light and without any other thought, it’s now permanently recorded.

In all honesty, other than for a cataclysmic event, the landscape’s change is
barely perceivable by our mind or memory. One of my favorite pastimes on
my travels is to look at the landscape knowing early US history and western
expansion and to realize that much of what I’'m seeing is exactly what my fore-
fathers saw as they traveled the west 150yrs ago. What is it then that all of a
sudden makes us stop, go nuts and in a panic, set up our camera gear to cap-
ture a landscape we might have seen a thousand times before? Light! All the
other “elements” in the landscape were always there; it simply took the right
light though to bring them all together in a photograph, where the light set off
an emotional response to the scene. If you’ve done everything right, you have
the photograph of a lifetime. You're a photographer!
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Landscape photography seems to grab every photographer’s attention even
if it’s not his or her main photographic interest. For a long time, | wondered
why, but not any longer. The landscape reminds us of so many things, wilder-
ness, our past wild heritage, vacation, parent’s cabin in the woods, a weekend
at the lake, life. As photographers, tapping into those personal experiences
of our viewers is the challenge and when done successfully, the reward of
our getting up early, bracing the cold and putting little of ourselves into our
image. There’s so much that goes into a successful landscape photograph,
we’ve touched on some of it here. Take this as just a starting point in your
lifetime pursuit to bringing to life the wonders this planet has to offer us on
our photographic adventures.
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Moose Peterson
Wildlife Photographer, Author and Educator

Moose’s true passion has always been and remains photographing the life history of our endangered
wildlife and wild places. Since 1981 he and his wife Sharon have dedicated their lives to this pursuit.
Educating the public about our wild heritage is their hallmark. Moose’s aviation photography has the
same goal of preserving our aviation heritage and the freedoms they protect, pictorial and oral for
future generations. Along the way Moose has been honored for his photographic passion: a Nikon Ambassador USA,
Lexar Elite Photographet, recipient of the John Muir Conservation Award, Research Associate with the Endangered
Species Recovery Program, just to name a few. He was part of Epson’s Finish Strong ad campaign. Moose was the
creative producer/photographer of his acclaimed film: Warbirds and The Men Who Flew Them. He shares his knowl-
edge through his writing, being published in over 143 magazines worldwide, author of 28 books including his latest,
Photographic FUNdamentals, Taking Flight and best seller Captured. He lectures across the country to thousands
upon thousands of photographers every year. One of the original Nikon shooters to receive the D1 in 1999, Moose
embraced this new technology, becoming the only wildlife photographer in the world to shoot strictly digital in the
early years. While a beta site for all the major hardware and software manufacturers, Moose continues being a cre-
ative innovator of new techniques both behind the camera and the computer, which is the driving force behind his
photography and goals.

Airshows and Fly-ins ... huh?

These two aviation celebrations, the airshow and fly-in, are a mystery to some
so | thought some explanation as to what they are is needed. There is a big dif-
ference between them when it comes to the events but not the great oppor-
tunities they afford us. They are target rich venues we aviation photographers
should at the very least be aware of as they happen around the globe. You can
summarize them both as a gathering of aircraft and aviation like-minded folks
but after that, they can be widely quite different.
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Generally speaking, airshows are where aircraft come and put on display be it
static and in the air. These are organized events where you have paid perform-
ers and you most often pay admittance to attend (there are some free air-
shows across the country). The big attraction is the aircraft that fly during the
event, the show in the air, which all airshows will have. You can find a list of the
majority of North American (MILAVIA Air Show Calendar - North American Air
Shows 2018) and European Airshows (MILAVIA Air Show Calendar - Air Shows
& Aviation Events) online, which provides dates, locations and often a link for
the airshow itself. These are one or two-day events. The main thing about air-
shows is as the name states, there is a show in the air with typically a headliner
event like the Blue Angels or Thunderbirds. They are opened to the public who
is encouraged to attend to enjoy the show.

The fly-in is similar yet totally different from the airshow. They are similar
because it’'s a gathering of aircraft but might last just for the morning with a
couple of aircraft or like the AAA / Blakesburg last for a week with hundreds
upon hundreds of aircraft from around the country. Some are on a Sunday
morning and they usually feature a pancake breakfast. Most are open to the
public while some are not. What makes Fly-ins unique is there is NO airshow,
no schedule of performers or acts. You could call them more of a social affair
but for the aviation photographer still a very rich target of opportunity. That’s
because while there is no airshow, there is still lots and lots of flying. And while
you can easily find dates and locations for airshows online, fly-ins, not so much.
You can head to fly-ins.com and get a hint of when and where some are but
some you’ll not learn about them until you get deeper into the flying commu-
nity. By the end of this section, you’ll understand better how working both into
your shooting schedule is a good thing for your aviation photography.
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Self-Preservation!

Yep, that’s the first thing | want to talk about when it comes to working air-
shows and fly-ins! If you feel good physically and mentally then shooting at an
airshow or fly-in is a successful, rewarding photographic snap. Having worked
an airshow or two and seen other photographers, | know that taking care of
yourself seems to take a back seat to the camera gear and the photograph.
But in the end, those two things suffer because the photographer is suffering
and there’s no need for that to happen. There are some really simple things
you can do to assure this doesn’t happen but because they are simple they are
really easy to overlook so let’s cover them now!

I've been privileged to seat in on airshow briefs. There are lots of things they
cover, and they can vary but the one thing every airboss repeats over and over
again from airshow to airshow is hydrate! They say it very straight face and
very seriously, “if you’re not visiting a bathroom at least once every two hours,
you are not hydrated!” This affects you physiologically in a couple of ways, the
most important is your vision and muscles. The bottom line is it’s very impor-
tant you drink lots of fluids, lots because airshows by their very nature are hot,
dry places that take their toll on the body. Water is essential!

What I've seen nearly all photographers take for granted when working air-
shows are their feet! You have no idea how the heat from the cement and tar-
mac is sucked right up through your shoes and transferred to your feet. Then
you have the fact you’re on them for a minimum of six hours shooting and
then the additional time spent walking about. All of this takes a huge toll on

54




Airshows: Get Beyond the Crowd Shot

Photosho

a kelbvone

P

World

onference

With MOOSE PETERSON

your feet and that takes a toll on your providing your camera a stable platform
in which to operate. When it comes to shoes then, | recommend like me, you
spare no expense. And a word of advice, don’t buy a new pair of shoes the day
before you go to the airshow. You’'ll regret that!

On the same line as dealing with thirst and your feet from the heat of the sun
is the direct effect the sun has on us. Sunblock is something you must apply
and apply liberally all-day long. You’re dealing with not just the direct sun but
the reflected sun coming off the cement and tarmac. It’s brutal so you must
take care. You can take this protection further by wearing a wide brim hat.
While | really hate them as they affect your peripheral vision and tend to blow
off at the most inopportune moments, they are protection from the sun. You
can take this even further by wearing long sleeve and PFG shirts. These block
the sun even further and with all the days in the year you are outside with air-
craft, this protection can really add up! Lastly, sunglasses are a must! | use a
pair of Jublos glacier glasses because they have such intense protection and at
the same time, stay on my head without having to put them over my ears. This
makes for very quick on and off while shooting.

If there’s a trick to working airshows when it comes to personal preservation, it
is knowing where to park. Most airshows have a website and they show park-
ing, it’s worth heading there and doing some planning. Even if you have to
leave your home or hotel an hour earlier to get that great parking spot, it will
save you in so many ways during the show. Getting the perfect spot means
you can have a cooler filled with cold water easily accessible, a place to sit and
even an opportunity to review your images or clean your sensor if need be.
The one thing you will find a real benefit is that at end of the day when you’re
deadbeat, getting back to your vehicle quickly is a lifesaver. Lastly, if parked
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strategically, it can be used as a locker for your chair or for gear like tripod or
lights in case you might need them at some point. Be aware that some air-
shows permit you to park almost on the show line with a little extra fee. | take
advantage that every time | see it available. It’s well worth the price!

One common asset many take with them to an airshow is a chair. You have

a number of options here if you want to go that route. There are a couple of
things to keep in mind when it comes to chairs. The main one is, it is some-
thing you will have to carry around with you along with your gear, that can be
a bit much at times. There are some new chairs on the market that while more
expensive than your basic folding chair, weigh practically nothing and fold up
to near nothing. I'm referring to ones like the Kelty Linger for example which
can hold 300lbs while weighing only pounds itself and fold up to nothing. |
want to warn you about the temptation of shooting from your chair. While
much more comfortable and it’s easier on your feet, it's murder on your pan-
ning technique. The chair can hold your spot, serve as a shelf for your gear but
when it comes to shooting, you need to be standing!

This is probably the oddest recommendation when it comes to taking care of
yourself at an airshow/fly-in but I’'m here to tell you, | can’t live without these!
You just have no idea how greasy your hands can get an airshow. Be it from
applying sunblock, sitting on the ground to the times you are with aircraft
and need to push them out, your hands get greasy! And it’'s Murphy’s Law
that as soon as your hands are greasy you need to grab your camera. It’s for
that reason | have in my sling bag (discussed in a moment) Permatex 25050
Fast Orange Hand Cleaner Wipes (25 count) and Nikon Pre-Moistened Lens
Cleaning Wipes. One is for your hands and the other for your gear after your
hands handle your gear. You'd be surprised how perspiration can also foul up
your gear. These simple things add up to making your day of shooting just that
more comfortable and therefore your photography more successful.
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Gear for the airshow

This is why | so love airshows ... aviation photography ... it requires nearly no
camera gear. You can literally shoot with one body and one lens all day and be
totally successful! Seriously, a D500 and a 70-200 lens and you’re rocking it.
You can start with that minimal amount of gear and be totally successful! With
that said, | hardly see any photographer anywhere with just one body and one
lens. Where is the fun in that! With that understood, let’s talk about gear for
working the airshow/fly-in as there is a maximum you want and that limit is
how much you can physically carry for a full day. Getting right to it, this is what
| have with me:

Nikon D5

Nikon D850

Nikon 200-400f4 VR2

Nikon 105f1.4 AFS

Nikon 24-70f2.8 VR

Nikon 14-24f2.8 AFS

Nikon SB-5000

Nikon 67mm & 82mm Polarizer

Nikon AN-SBR2 Rapid Strap (for 200-400)
Really Right Stuff Ground Pod (for early morning statics)
m Knee Pads (for early morning statics)

m Vulture Equipment Works A4 Camera Strap
m Mountainsmith Sling Bag

m iPad Mini

m Business cards
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This might seem like a lot of gear to carry around all day, but actually, it’s very
manageable (doesn’t even get in the way of me eating ice cream!). To under-
stand how that is | need to explain my “system” for working an airshow/fly-in
with this gear. The heart of it all is the Mountainsmith sling, what they are now
calling their Day bag (it’'s changed names a couple of times since | got mine).
To this add their Strapettes strap and now the sling bag with all the gear but
200-400 rides amazingly comfortably on your back. Add their Lens Cube to
the inside and you have what | think is the perfect camera bag for airshow /
fly-ins. It holds ALL the gear | list above with the SB-5000 riding in an outside
pocket except the 200-400. The 200-400 is attached to the AN-SBR2 strap,
the D5 riding on it. The rest is easily and quickly accessible even when it’s on
your back. And there you have it, real simple!

Two tools | have listed here are new to our discussion, the iPad and business
cards. | need to step back for a moment to explain these. One of our goals
with attending airshows/fly-ins is not just great static or ground to air photos,
but to get up in the sky with the aircraft themselves in an air to air photo mis-
sion. | said that you could be a very successful photographer at an airshow
with just one body and lens. That is very true. But if we move our goals for-
ward to that air to air photo mission, that would be a challenge with just that
one body and one lens if you don’t come across as a professional as well (pro-
fessional is a state of presence and not just how you make your money). You'll
find real fast the plane owners and pilots still work on the very old system of a
handshake and business card. Those two things are how business is conducted.
And a vast majority of pilots have iPads. They use them for flying (charts and
the like) and we use them to share our photographic success. To the photog-
rapher with higher goals, these tools are just as essential as the body and lens
you want in your sling bag!
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With that in mind, here’s my two cents worth on these two essential tools.
When it comes to your business card, KISS works the best. This means it has
your name, address, email address, and cell phone number prominent. Many
put cute business names big and bold on their card. You’re asking a lot of
someone to associate your cute business name with your own name. Stick with
your own name, it’s branding enough! And keep the card clean, don’t use a
photo that you like today because in six months when you still have five thou-
sand cards left, that image will be old and dated. And with the iPad, do the
same thing. Keep it clean, have images easily accessible and organized so you
can find what you need in a snap. Being a professional is a state of mind and
presentation so separate yourself from the crowd making your presentation
just that, professional.

The airshow’s big secret

Our success in getting into the skies to photograph an aircraft lies with those
images we capture of them while they are on the ground. Statics are so impor-
tant to our start and continued success in aviation photography! And light is
essential in photography. So when you combine the two necessities, statics,
and great photography, whenever you can be with statics in great light we can
accomplish our goals. This brings us to the big secret in airshows, the early
bird or sunshine pass (fly-ins are different, no admission costs period normally
with no set hours of operation).

Many, many airshows offer early entrance passes often called the early bird or
sunshine pass. They typically go on sale the very moment the general admis-
sion tickets go on sale for the airshow and often are snapped up instantly.
Regular airshow goers who simply want the best seat in the house often buy
these passes. They rush in in the predawn hours, place their chairs on the flight
line by show center and then leave their chairs until later. Jake and | have been
to some airshows where all these passes are sold out yet we find ourselves all
by ourselves photographing the aircraft. The number of tickets sold is always

a limited number so even if all purchased by photographers, you still have the
aircraft to yourself making for magical sunrise moments with statics.
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One sunrise pass opportunity | particularly love is at the Planes of Fame
Airshow each May. The access to the large assortment of classic aircraft, vin-
tage, warbirds, and jets is staggering! The pass gets you preferred parking
which is a big help so can easily ditch that tripod you needed for predawn
photography after the sun comes up. They provide a free tram taking you right
to the aircraft and have minimal ropes around the aircraft. This permits easy
access to the statics and the rest of the airshow. Finally, they have the aircraft
parked far enough apart that works really well for static photography. And one
small but important point, they have food vendors that open early and serve
hot coffee and breakfast (we must have our priorities).

Some airshows like EAA AirVenture / Osh, have no early bird pass because the
ramp is open basically 24/7. You just have to get up early and make the walk to
be with the aircraft parked on the grass, but there are no ropes or gates. Jake
and | are always surprised with the tens of thousands of folks in attendance
but there are never more than a handful of us crazy photographers out there
to greet the sun with the aircraft (and yes, they have hot coffee and breakfast
too). Why aren’t there more photographers out there on the grass with all the
aircraft at sunrise? It’s a secret, remember?!

There’s more to an airshow than the air show

The obvious reason to go to an airshow is the airshow itself. The performers
and acts that fill the skies with excitement and grace are what we want to fill
our viewfinders and photographs with. | want to encourage you though to go
further as an aviation photographer and that requires understanding there is a
whole lot more to the airshow then just the show in the air. We most definitely
want to photograph the aircraft in the air but that is just one of the priorities.
But most shows begin hours after sunrise and in those hours, we can accom-
plish much as photographers. This is an important lesson | luckily learned early
on. This is when we expand our opportunities by remembering that aircraft are
all about people associated with them.
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Here is where your comfort level might be tested, at least it was and still is

for me today. The aircraft are only at airshows because someone owns them,
maintains them and flies them. Without that human involvement, aircraft cease
to exist. This very obvious fact was totally lost on me in the beginning and
when the light bulb flicked on, aviation photography took on a whole new life,
importance, and success. So those hours when planes are statics and the light
isn’t exactly at its best is when we need to work even harder to make the pho-
tographs and hone our skills as visual storytellers. How do we go about that?
We get to know those people!

The first suggestion | have has nothing to do with shutter speeds or f/stops.
The best way | know to engage with those with the aircraft is by simply ask-
ing questions. Talking with the plane owners and pilots (often one in the same)
about their aircraft is one of the best ways to get involved and access. This is
an art all to itself and one I'm still getting better at. You start by understand-
ing where the other party is coming from, an important part of communicat-
ing. Pilots are a unique group, they are smart, funny, intelligent and selective in
whom they let into their world. It’s hard to understand until you are welcomed
into that world and have a hint of where they are coming from. It’s a mutual
respect you need to start, foster and nurture your entire career and it can
begin at the airshow during these dead light hours.

How do you begin such a conversation with a total stranger? The way | did it
was to head to the aircraft that | had the greatest photographic interest in. This
interest wasn’t in an aircraft that | wanted to do an air to air with necessarily
but simply one that at that airshow was the visual standout. (Want to make an
interesting photograph, stand in front of something interesting!) With the nar-
rowing down of the aircraft, you watch for when it appears there is someone
with that aircraft which might take some time. Use that time if you can to do
some quick research. It might be as simple as reading the info poster with the
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aircraft, reading a write up in the show guide (which you should buy for just
such reasons) or get on your smart device and do a quick web search (search
the N Number can work wonders). With this brief research you should have
enough to walk up to the pilot, not interrupting him, and simply as, “What’s it
like to fly this gorgeous plane because you make it look like so much fun?”

The question you ask whether this or another, it has to be not only sincere but
the start of a bigger conversation. I’ve seen all sorts of approached used and
most aren’t successful because they end with a simple answer. This means

you don’t ask a question that is answered for example, on the poster with the
aircraft. You don’t ask a question you know the answer to showing off your
knowledge. What is considered successful? A conversation wherein the perfect
world, you are invited on the other side of the rope (if there is one) and provid-
ed a closer inspection of the aircraft. More importantly, you get closer to the
pilot who is all on their own a very interesting story. And in getting to know
that story and perhaps telling it, you begin to tell the story of the aircraft.

And before you start this whole process you have to be prepared for success.
What preparation you ask? Photographically for example, how are your por-
trait skills? We’re doing all of this preparation prior to the airshow and during
the hard-light hours of mid-morning (shooting with a friend and having them
stand in as the pilot to get your basic settings set prior to meeting the pilot is
smart shooting!). The first tool you need to pull out is the flash. The next tool
is the wide angle lens so you can photograph the pilot WITH their plane. Do
you have those tools and techniques in your camera bag? Do you have your
business readily available to instantly put in their hands? That’s just part of the
preparation you need to have before you ask that intro question.

Next and probably even more important, do you have the tools for the follow-
up? In any relationship but especially with a new one, follow up is important for
that relationship to grow. As a photographer, how can you do that and at the
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same time grow that relationship? How can you do that while keeping that end
goal of a possible air to air mission in sight? The first thing is you have busi-
ness cards! I’'m not talking about cards for your normal day job if you’re not a
fulltime photographer (being a fulltime photographer is not required), but ones
you’ve made for your aviation work, which can be as simple as your name,
phone number, and email address. You don’t have to spend money on a logo
or printing some photo on the card, just the basics for communication. Cause
after you’re done, you hand them that card and tell them you’ll be in touch so
you can send them prints. That’s right, prints!

Then once this is all done, you make darn sure that you get at least one good,
strong image of that plane the pilot is flying. Be it from the early morning sun-
rise pass or from the airshow, you get that photograph! With that, you now
have two photographs to present the pilot, the portrait and the aircraft. That’s
two prints and not just two thumbnails attached to an email. That’s two prints!
And after the airshow, you follow through with your commitment, that hand-
shake and you get those two prints (it could be more) in their hands! It sounds
so simple, so obvious yet it’s rarely done. Being the exception is how you move
forward in aviation photography. Just keep reminding yourself, “If Moose can
do this then so can II”

Where to stand?

Yep, there is even a strategy where to stand at airshows! But there isn’t just
one strategy but many and the one you select will make or break your success.
The thing is, how you measure success will dictate your strategy for where you
stand. What should your strategy be? What if it’s your first time to that airshow
or any airshow? What about if it’s your twentieth? There really is a lot to think
about and there is really no perfect answer, no wrong answer just ones that are
better than others. Here are some thoughts to help you with your strategy.
Show Center is a location on the crowd line that all the performers use to
determine the center point of their acts. As the name suggests, is in the middle
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distance of the crowd line usually running parallel with the runway. The planes
themselves normally fly five hundred feet or further out from the audience
over a runway, this is not show center. Even if you’ve never been to an airshow,
you can determine where show center is simply by finding the show announc-
er. They are on some type of raised platform, so they can easily see the air per-
formers. Typically, you’ll see a soundboard near them. This is show center and
where many photographers like to stand. This is because when the performers
fly their acts, the majority of their maneuvers focus on show center. When they
dive back down, from this position you will see them in your viewfinder seem-
ing flying right down the lens barrel. You can get this from other locales but
show center this is almost a guaranteed shot.

To swing the pendulum to the other side, your strategy might be to stand
where you have the best light. How do you determine that especially if you're
new to that airshow? The majority of the airshow is flown parallel to the crowd
line, so you can use your hand, “fly it” back and forth in the direction as the
crowd line and look at the light on your hand. This provides you one pos-
sible strategy based on the light. Next, often airshows have the performers fly
what’s called a “photo pass.” Another term for this is a Banana Pass. That’s
because the flight path taken during this pass is the basic shape of a banana.
A majority of the time the direction of this pass is left to right, banking in from
the left of the crowd line, following the crowd line down and then banking
right at the end. This pass puts the aircraft in a bank, so you see it from the
top rather than from the side (like you do when they just go up and down the
flight line). With the right light and you’re standing in the right place, the pho-
tograph looks like it was taken air to air. The right place is? Where the light is
at its best!
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Another strategy when it comes to finding a place to stand at an airshow is
either on the crowd line or back in the crowd. | mentioned before how some
get sunrise passes just to hold their spot on the crowd line. This is so there

is nobody in front of them when they are shooting. There is no doubt that at
times, this can be the only place to stand. When are those times? For me per-
sonally, it’s when the combination of light and background make it worth being
there. The one photograph you can get from the crowd line you can’t get any-
where else is the launch and recovery of aircraft (take off and landing). If you
want that shot, you have no option. If you have this spot, unless you have a
chair or person to hold your spot, you’re stuck there the whole show. On the
other hand, if that launch and recovery shot isn’t a priority, you can stand in
the back and get all the shots of planes flying you desire. And standing in the
back you have the ability to move around. One drawback, that’s when that
father puts their kid on their shoulders right in front of you!

Another strategy when it comes to where to stand is the all based on the plane
the pilot is flying, who you just meet. Is it a warbird or a performer, a jet or
prop, fast or slow flyer, fly at the beginning of the airshow or at the end? Any
and all of these might impact your strategy where you stand. Remembering
that end goal of having that great photo you can print and send to that pilot
might totally determine your strategy for the airshow. Understand that at times
the answer is really obvious and at other times, it is not. There will be times
when you will not be in the right place at the right time. There will be other
times when you can’t be in a better place. All of these happen to all of us. One
thing you can do to maximize your success is to attend BOTH days of an air-
show changing your strategy each day.
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Why would you want to spend two days at an airshow, let me count the ways!
Your handholding and panning technique is so much better the second day!
You’'ve watched the show so now know what to expect the second day. The
weather is never the same two days in a row. You know what images you
missed on Saturday you can get them on Sunday. You know exactly where you
want to stand as your strategy changes. The list of reasons why you should

go both days just keeps on going. You have a sunrise pass and you can only
really photograph thoroughly one static at sunrise simply because time runs
out. You can get another the second day. How about on the first day you got a
good photo of that plane the pilot was flying that you meet? Perhaps going by
and showing him that image on your iPad or taking them a print the next day,
that sound like a good reason to go the second day? Knowing you’re coming
back the second day can greatly influence your strategy where you’re going to
stand the first day.

The last thing | would encourage you to think about in picking that place to
stand is your handholding and panning skills. Whether intentional or not, you
are going to get bumped by the public who know nothing about photography
and are just there to see the planes. They will stand up in front of you, crowd
you on your sides, all are things that can and will throw off your panning. One
other thing to consider is that more often than not, your panning will be a 360
operation and not simply right in front of you. There are TONS of photo opps
that happen behind the audience as well as in front. You need to be able to
turn in place to catch it all.

One more thing to throw into this strategy is all your gear. What are you doing
to do with all of it while you’re shooting the airshow? When I’'m shooting the
airshow, the majority of the time I'll shed the sling bag because it makes it
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easier to pan with less wear on the old body. When one’s attention is on the
action, it’s not going to be on that sling bag on the ground or in a chair. | do
one of two things, leave the sling bag with Sharon or wrap its straps around
something so it can’t just walk away. We have never had any issues at an air-
show but regrettably know others who have. Where you stand could possibly
influence this issue.

Do you start with the big ones?

Years ago, we filmed a KelbyOne class on shooting airshows. It was filmed

at the delightful Florida Int’l Airshow at Punta Gorda. | choose there to film

a class for KelbyOne in part because while being a great airshow with killer
photography, it’s small community airshow. Another such airshow is the Cable
Airshow in SoCal, the first airshow of the year for the last forty-two years. The
number of aircraft might be less but they are more diverse and crowds are less
and for the new aviation photographer this is perfect! When just starting out
this is the perfect formula for building your confidence, files, and relationships.
The beauty is, there are lots of smaller, community-oriented airshows around
the world that you can “cut your teeth” on very easily.

The “Barbie IlI” is still the only example of a B-25H flying today. It’s truly a rare
warbird. In that KelbyOne class on shooting airshows, you saw me go up to the
crew of the B-25H “Barbie IlII” and introduce myself. Back then, you’'ve gotta
understand, | was scared to death to do that! But there was a class to film so

| had no option which looking back was a good thing for me. And working a
smaller airshow, there were fewer people, fewer photographers providing me
more opportunities to walk up and start a cold conversation with a stranger.
You can watch it all unfold right there in the class. | photographed the air-
craft, | photographed the pilot and crew and then we were permitted to go
up into “Barbie IlI” and film inside. Our sincerity opened up the doors quickly
to our cameras. But what you didn’t see unfold on camera came the next day;
Monday after the show was over.

The following morning, weather permitting, they would be ferrying the B-25H
“Barbie IlII” back to its home airport. When the cameras went off on that
Sunday, | talked with the pilot about the possibility of doing an air to air mis-
sion the following day when they ferried the B-25H home. He said that was
doable, even had a photo platform | could use as long as the weather cooper-
ated. We exchanged phone numbers and | crossed my fingers. At 03:00 the
next morning a tremendous crash of thunder almost threw us out of our beds.
One of those monster Florida thunderstorms was moving through the area. My
first thought was there goes the flight (I've had many, many air to air missions
postponed because of weather).

At 06:30 my phone rang. “There is a window in the weather and we’re going
to launch in forty-five minutes, can you be at the airport by then?” Thirty
minutes later we were on the ramp shooting statics on a wet ramp with the
storm still threatening. Minutes later | was in the air shooting photographs that
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would become the centerpiece of an article on the B-25H “Barbie IllI” and their
mission. And all of that came about because we were at a small airshow and
walked up and talked to a pilot. I've lost count how many times the story as
unfolded that way with a successful air mission under my belt, the next one is
just around the corner. While there is no guarantee in this business | personally
recommend you start at the smaller airshows and continue going to them long
after you’ve established yourself at the big airshows. Just like in wildlife pho-
tography, it just takes one cooperative bird to make your day!

Is there a photographic strategy?

By now you can probably answer that question for yourself with confidence.
The first answer should be of course as it’s up to your own goals! Airshows can
be photographically very addicting though and at times, throwing you off your
goal. | speak from personal experience. With that past experience, | want to
provide you with a couple of strategies that might keep you working towards
that end goal of an air to air photo mission. It’'s important to understand that
the strategy like your photography will grow with time. If you have none in the
beginning that’s normal so don’t sweat it. There is a lot to think about in this
whole process, which is why we go to lots of airshows.

Probably one of the most common strategies of photographers at an airshow
is simple stock photography. Stock photography you could kind of think of as
running a grocery store and needing to fill all of its shelves with a vast vari-
ety of products to fill every taste. You need the shelves lined with all those
products, so you can cover all the changing trends in tastes. As the old say-
ing goes, “You can’t sell from an empty cart.” When it comes to aviation pho-
tography and the many editorial markets, the more varieties of aircraft you
have in your files the more clients you can help. Just having a huge inventory
of aircraft photos in itself is not a business strategy nor an airshow shooting
strategy. But it’s a strategy that might just help you move forward. Let me
use myself as an example.

The first airshows | went to, my focus was just on warbirds. Warbirds, as I've
mentioned, are generally thought as WWII and Korea era aircraft. There’s no
doubt at airshows, they are a huge draw especially when they are in the air.
They are an aircraft that to this day | focus in on as there are so many different
ones as well as there are many different unique aircraft within a warbird type.
The strategy in the beginning for me was just warbirds, statics, and in the air
the first year and it laid a good foundation. It was obvious though that there
were more aircraft that | was missing and needed in my files then just warbirds
if we were to continue on.

This is when | started to delve more into Antiques, a period of aircraft from
WWI to WWII. Most simply think of biplanes as antiques but there are much
more than just those. This is how in part | got into fly-ins but more on that in
a moment. This actually leaves a really big hole on my selves for buyers and
that’s modern military aircraft. To this day, that’s still a big hole in the files and
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the reason is pretty simple. While | love watching them fly, photographically
unless there is killer light, they just don’t excitement me photographically. At
the same time, there are some really amazing photographers out there that
just photograph modern military hardware and know the subject and have a
heck of a lot more contacts than | do. With time being precious, | have few in
my files.

Conversely, you might not like antiques or warbirds and just love modern mili-
tary. If this is the case, then there is your product to line your shelves with for
your customers. Airshows are a natural for you as you have access often to mil-
itary aircraft you can’t just drive up and see at an airport. With all the possible
variants, you can keep quite busy and become quite successful with this genre
of aircraft. In that same KelbyOne airshow class, you see me walk up and work
with a F-22 pilot. So, the same strategy can work with modern military aircraft
as all the rest. And with that, you have the basics for stock photography strate-
gies at an airshow.

The one strategy | typically focus on at airshows is the editorial market. So,

we are all on the same page, editorial generally means magazines. There are
hundreds of magazines published worldwide on aviation every month. These
magazines are photographically driven, they need our photographs to tell their
story. You can be a part of this simply by working with the stock photography
strategy | just talked about, something we are part of. But the editorial strategy
means you’re not just producing a photo or two but rather an entire text/photo
package. That is, you’re writing the whole article and illustrating it with your
photographs. The editorial strategy all begins with the photographs because,
without them, you have nothing to write about.
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Don’t let the thought of having to write an article (they are only 1500-1800
words) or produce an entire article from two days of shooting at an airshow
scare you off! Like everything in photography, slow and easy wins the race. But
by starting to think about this and actually working at making it a shooting
strategy you’ve already taken the biggest leap. When you remember that as
photographers, we are already visual storytellers so all you’re doing is taking
your photography to its next natural extension. How does this all work then?

It starts by having a subject at the airshow that interests you that you want
to tell its story. It could be the airshow itself, a particular pilot or airplane or
period of history or any combination thereof. The possibilities are truly end-
less once you give your mind over to the opportunities. With that, you come
up with your own basic shot list you think you need to tell that story. You go
to the airshow, you work on capturing those and many more images. And then
afterward, you assemble the package and get it into the hands of an editor.
You might be saying to yourself, “Moose is making this sound awfully simple.”
As long as you remember that it is all built with great photography, you're
good to go. If you don’t keep in mind that it’s all about the photography, the
odds of success go downhill fast. So, the editorial strategy might not be one
you start off with right from the start but rather, work towards it with more
time behind the camera.

One of the most common strategies for shooting at an airshow is the personal
assignment. This can take one as many aspects as there are people attending
an airshow. The one strategy that actually turns out to be a common subject in
my viewfinder is the family outing. Taking photographs of mom or dad (there
are just as many women in aviation photography as men!) taking pictures of
their kids is a killer subject! | know a photographer that goes to the airshows
looking to get that one new aircraft in their files as a static that they finish
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in Photoshop to look like a painting. Their personal assignment is to create a
portfolio of these “paintings” that they love sharing with folks.

Probably the most common personal assignment is family history. A member
of the family flew either commercially or in the military and airshows are sim-
ply a great way to connect with that past. Their photographic strategy is no
more than the truest use of photography, to record memories. And that’s a
beautiful thing!

Another strategy, which takes absolutely nothing to explain, is going to air-
shows for the sheer fun of it! Yeah, airshows are just an amazing amount of fun
and we can’t ever get enough of that in our photography or lives. Going with
no strategy, no design other than just to have fun is perfect and works for so
many so don’t ignore this very obvious one.

Finally, what so many do is go with a strategy that combines all of these. For
me personally, and for my whole family (because even today, this is a fam-

ily affair), we combine a number of these strategies. Stock, editorial, family
memories, and fun are combined into every airshow we attend. Now one of
these strategies might be of higher priority than the others at a particular air-
show, but there is always some endgame in mind at the start of the weekend.
And that keeps us moving in a forward direction to capture the photographs
we need to tell the story. The purpose of a strategy is avoiding making the
comment after looking at all your photos saying, “l wish | had taken that one.”
It does happen but with a little thought and planning, you can minimize it and
just come back feeling rewarded for your efforts.

You might think that gaining that air-to-air as being the pinnacle of success of
such an event, but actually, it’s not. Being able to turn the event into an article
published might seem even better, but we’re still not there. Getting close to the
pinnacle of such a fly-in is all of things along with establishing a relationship
that extends past the fly-in! The vast majority of these pilots and plane own-
ers have more than one aircraft and more than likely have a project back home
they are working on. Project is the term that is used for an aircraft that is being
restored. It’s making that connection that establishes the long-term relation-
ship and many, many air-to-air photo missions and articles.

Aviation photography like all photography is in large part a process, a process
of growth, longevity, and passion. One airshow or one fly-in let alone a dozen
are still just a start. There is a story in aviation. A student with 400 hours of fly-
ing feels like he has tons of experience. He talks to another pilot who has 5000
hours and speaks of his tons of experience of 400 hours not knowing the pilot
has 5000 hours. The 5,000 hour pilot then tells about when he talked to a
pilot with 10,000 hours who said, “I have 10,000 hours and I’'m just learning all

| don’t know about flying.” The moral is, in aviation, we must continually work
at our craft to get better but we’ll always be learning.
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Dave Black
Photographer, Educator and Author

As a freelance photographer for over 30 years Dave’s work has primarily centered on the sports
industry for such publications as Sports lllustrated, Time, Newsweek and the award winning TV
show Sports Century on ESPN. The list of event coverage includes the Masters, Kentucky Derby,
National Football League, NASCAR and extensive work regarding the United States Olympic
Committee, Olympic athletes and coverage of twelve Olympic Games. Known for his creative use of lighting and
in particular with the artistic technique of Lightpainting, Dave’s portfolio continues to broaden into the commer-
cial and advertising industry, and with specialized lighting projects including work for the National Geographic
and their book Where Valor Rests, Arlington National Cemetery. He is one of Nikon’s “Legends Behind the Lens”
photographers and is a prominent instructor at a variety of workshops each year. His monthly website tutorial
articles “Workshop at the Ranch” attract more than 85,000 unique visitors monthly. In 2010 he released his highly
acclaimed instructional book, The Way | See It. To see Dave’s images, learn more about photography, or purchase
his book visit his website www.daveblackphotography.com.

This class is for any photographer wanting to learn about using FLASH with
High Speed Sync mode for photographing Sports Action.

Skateboarder Half Pipe ... Nikon D750(Group Area AF), ISO1000, 1/4000 at
f14, Nikon 14-24mm lens, WB 6250K, 4 Nikon SB-910 Speedlights Manual Full
Power mounted in the FourSquare Soft Box, Painters Pole used as a lightstand,
RadioPopper system, Nikon SU-800 Commander, SanDisk 32G Extreme Pro
Flash Card.

NOTE: Here is a link to my website Behind the Scenes video that follows me
throughout the photo shoot using Nikon Speedlights in High Speed Sync (HSS)
with Half Pipe X-Games Champion Jono Schwan:
http://www.daveblackphotography.com/behind-the-scenes-video/
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NOTE: Nikon users need to set their camera to AUTO FP 1/250s in the Custom
Settings Menu under Bracketing/Flash. Canon users can activate High Speed
Sync (HSS) directly on your Speedlite. These procedures for each unit activates
the High Speed Sync (HSS) feature which enables the Speedlights to perform
at shutter flash sync speeds faster than 1/250 of a second so you can stop the
action ...ex:1/500, 1/1000, 1/2000 and even 1/4000 shutter speed.

These HSS Flash Action images made with Nikon Speedlights, Profoto B1
strobe are all set in High Speed Sync mode and make use of a Triangle Lighting
Configuration.

Half Pipe Skateboarder .... Nikon D750, ISO1000, 1/4000 at f14, Nikon 14-24mm
lens, WB 6250K, 4 Nikon 910 Speedlights High Speed Sync Manual Full Power
mounted in the FourSquare Soft Box, Painters Pole used as a lightstand,
RadioPopper system, Nikon SU-800 Commander, SanDisk 32G Extreme Pro
Flash Card

Here is the final picture using Speedlights and a Triangle Lighting Formula:
Camera, Subject, 4 Speedlights Off-Camera mounted in a FourSquare Softbox.
By purposely underexposing the image by -1.7 the background scene becomes
dark. The use of Flash will make my subject “Pop” from the darkened back-
ground scene.

| will typically use 4 Speedlights at Manual Full Power output to illuminate my
action subject and reveal them from a purposely -1.7 underexposed exposed
scene during bright sunshine conditions. Overcast skies might only require 2-3
Speedlights at Full power but that also depends on how close the Speedlights
are to the action subject.
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Soccer Scissor Kick ... Nikon D810 (Single Point AF), ISO800, 1/2500 at f14,
Nikon 14-24mm lens (at 19mm) with Polarizer Filter, WB 6250K, 2 Profoto B1 Air
strobes in High Speed Sync mode with clear glass Protection Plate and Telle-
Zoom Reflector, Manfrotto Lightstands, SanDisk Extreme Pro 32G Flash Card.

Clouds in the skies provided an awesome backdrop for our athlete. This set-
up makes use of 2 B1 Air strobe units in High Speed Sync that are placed Off
Camera to the left and right of the athlete just out of the frame. By purposely
underexposing the scene by -2.0 and using a Polarizer Filter | increased the
drama in the sky.

Each B1 Air strobe is set at FULL Power and has a Tele-Zoom Reflector, while
my camera is set to a fast action shutter speed of 1/2500.

I’m lying on the ground next to a gymnastics crash matt which allows a com-
fortable landing area for the athlete who made 15 Scissor Kicks. My low angle
of view gives the impression of great height to our athlete and easily places him
against the entire sky.

74




Sports Action High Speed Sync Flash

Photosho

a kelbvone

P

World

onference

With DAVE BLACK

Baseball Slide ... Nikon D750, 1SO250, 1/4000 at 6.3, Nikon 80-400mm lens (at
230mm), WB 6250K, 2 Profoto Bi Air strobes in High Speed Sync mode with
clear glass Protection Plate and Telle-Zoom Reflector, Manfrotto Lightstands,
SanDisk Extreme Pro 32G Flash Card.

A similar 2 strobe lighting set-up as Image #3 Soccer Scissor Kick, | placed 1
strobe camera left and slightly behind the player’s right shoulder. This slightly
backlights the helmet and flying sand.

The second strobe is placed camera right and slightly in front of the athlete. This
strobe illuminates the face with Rembrandt Lighting with a triangle of light vis-
ible under the athlete’s right eye.

To learn more about shooting Sports Action with Speedlights and Strobe
Lighting systems with High Speed Sync checkout my video classes on
KelbyONE and my Instructional Blog page: Workshop at the Ranch www.dav-
eblackphotography.com ... type: High Speed Sync in the SEARCH Box.

Adios. Dave
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Lindsay Adler

Portrait and Fashion Photographer

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion
and photography publications including Marie Claire, InStyle, Noise Magazine, Zink Magazine,
Rangefinder, Professional Photographer and dozens more. As a photographic educator, she is one

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and most presti-
gious events. A clean, bold and graphic style has become the hallmark of her work, whether shooting advertising
campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay
is renowned for her creativity and collaborating with designers and stylists in order to create fresh looks. An
author of four books, she is always working on new ways to share her passions and knowledge with others. Each
year she teaches to tens of thousands of photographers world-wide through prestigious events.

Part I: Get to Know Your Subjects

m What do they value, what are their passions?

m Questionnaire on shoot goals, visual preference, inspiration, hobbies, and more
m Why did they hire you? Why are they doing this shoot?

m Make it an experience and collaboration

Part 2: Develop a Concept
m What is the purpose of your shoot?
m Concept makes more impact and emotional value
m Concept informs all creative decisions
v Lighting, color palette, posing, props, hair/makeup, wardrobe, composition
location, retouch

Part 3: Plan Ahead
m Make it an experience
m Plan hair, makeup, wardrobe

m Mood board: Collection of images that express the concept and creative
direction of the shoot. It helps you visualize and the subject, hair, and make-
up prepare.

Part 4: Look Expensive (but save $$$)
m Looking expensive doesn’t require something to BE expensive
m Purchase Cheap: Amazon.com, Chinese dress merchants, etsy.com
m DIY: Create using “found objects” or everyday items from craft shops, home
decor stores, online crafts and more.
m Barter and Trade: Provide images to exchange for products and services
m Wardrobe
v Vintage and consignment shops
v amazon.com
v Costume Rental (theater, opera, costume)
v Fashion design students
v DIY (tulle, scrap fabric)
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Part 5: Finishing Touches
m Retouching: Blemish removal, even out blotchiness, brighten eyes, liquefy, etc.

m Color Grading: Adjusting colors and tones to transform the mood of the image.
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Glyn Dewis

Photographer, Retoucher and Trainer

Glyn Dewis is a professional photographer, retoucher, and trainer based in England. Glyn’s pho-
tography and retouching sees him working for national and international clients ranging from
the BBC, Sky TV and Air New Zealand to athletes, musicians, and other industry professionals. A
Photoshop World Dream Team Instructor, KelbyOne Instructor and Adobe Influencer, Glyn also

teaches his own series of workshops, provides one-on-one coaching and presents at events around the World cov-
ering all aspects of Adobe Photoshop from basic to advanced techniques. See his work at glyndewis.com and find

videos on his YouTube channel at youtube.com/GlynDewis.

There was a time when
| honestly thought that
lighting was some kind
of dark art; something
I'd never be able to
grasp, something that
was for those advanced
photography types.

I’m someone who has
to break things down
step by step and almost
rewrite how it is done

in my own language to
make it, for me, much
more simple to grasp
and logical. This is what
| want, no, | WILL show
you in this session.

| never in a mil-
lion years thought
I'd be talking about
Rembrandt Lighting let 1

alone showing how YOU

can do it but believe me when | say that there are just 3 very simple steps to
follow that will not just show you how to create it but to do it without giving it
much thought.

If I'm honest, when | first started out | tried to learn too much too soon and |
very quickly became a Jack of all Trades and Master of None, so it wasn’t until
| made the decision to concentrate on a particular style of lighting that every-
thing slotted into place.

This is where | want to get you! | want to not just tell you but show you that
portrait lighting is EASY!

78




Portrait Lighting is EASY ... Trust Me!

Photosho

a kelbvone

P

World

onference

With GLYN DEWIS

Split Lighting
We'll start off by showing Split Lighting where the light source is positioned
facing the subject directly from the side (Figure 1).

Positioning the light in such a way would mean that one side of the subject’s
face is lit and the other in shadow which is great if you’re going for that partic-
ular look. However, for our Rembrandt Style of lighting, we need to make some
minor adjustments to the light...

Cross Lighting

In this 2nd example
the only difference
here is that | moved
the light source
closer towards the
camera position; still
side on but following
a straight line away

from the model and /l\

towards the camera.

You can see here
(Figure 2) that by
moving it further
to the front of the model we are starting to get light illuminating the shadow
side of the face. | explain how far forward to bring the light in the Photography
Videos and you’ll see that | go through a very simple technigue that will have
you positioning your lighting quickly and easily giving perfect results every time!

During the class,

we’ll look at

how perfect the

Rembrandt Lighting

style by varying the

angle/tilt of the light |
to achieve the trian- N

gular pattern of light
on the shadow side
of the face and again
you’ll see how to do
this step by step in
the class.
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Invisible Black Background
What is the invisible black background?

As the saying goes, a picture is worth a thousand words, so here are before
and after pictures to show you what | mean.

.

e~

Before

There’s no question that having this technique in your photography tool bag
can save you a lot of time, effort, and money. It also allows you to add a little
extra creativity to your shoot and create photos that you may have thought

were only possible in a studio or with a collapsible backdrop.

How do we achieve the invisible black background?

Basically, what we’re looking to do is tell the camera to capture no light other
than the light we introduce—in the form of a speedlight flash, for example. We
don’t want the camera to pick up any of the ambient light. By doing this we
have an instant black backdrop.

This technique can be done with any camera that has a Manual mode and the

ability to trigger off-camera flash—that means SLR, mirrorless, and some point-
and-shoot cameras.
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There are only five steps to it.
1. Manual Mode - Put your
camera into Manual mode.
Yes, now you are in control
of the shutter speed, aper- oS o
ture, and ISO. From this point JIF a ' [}9
on you’re telling the camera ; '
what to do rather than allow-
ing the camera to make the
decisions and give you the
picture it thinks you want.

=} WB AF-DRIVE 450-B2

IS0 100 6

2. ISO - Set your camera to its lowest possible ISO. The ISO dictates how sen-
sitive your camera’s sensor is to light. A low number like 200 means it’s less
sensitive to light, whereas a higher number like 1600 means it’'s more sensitive
to light. The higher the ISO number, the more noise there will be in your pho-
tograph, particularly in the shadow areas. Now, seeing as how we’re looking to
make a black backdrop, we’'re not concerned with how sensitive the camera is
to light so keep the ISO as low as possible. My Nikon D3 can go down to ISO
100, which means the camera won’t be very sensitive to light at all and the
final picture will be nice and clean with minimal noise.

3. Shutter Speed - Set your camera to its maximum flash sync speed. This

is the maximum shutter speed at which your camera and flash can work
together; any faster than this and your camera’s shutter will open and close
too quickly to allow all the light from your flash to fill the camera’s sensor.
Common maximum sync speeds are around 1/200s to 1/250s. Although we
could quite easily make the scene completely black by using an incredibly high
shutter speed like 1/8000s, the problem with this is that the shutter will open
and close so quickly that none of the light from the flash will hit the sensor. So
we must stick to the maximum sync speed that allows our cameras and flashes
work together.

4. Aperture - The final setting on your camera is the aperture or the f-number.
Knowing roughly what f-number to use will become second nature after you've
done this a few times. The best thing to do is choose /5.6 and go from there.
Once you'’re at this stage, take a photo of your subject and see what results
you get. The objective here is to see absolutely nothing on your camera dis-
play; you should see a completely black screen. If you see a bit of the environ-
ment then clearly some ambient light is creeping into the scene. All you have
to do to fix this is close down your aperture a little. For example, if you’re cap-
turing some ambient light at /8.0 (Figure 7), then try stopping down to f/11 or
even f/16 (Figure 8) and see what that gives you.
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5. Flash - Now you’ve set the scene
with your camera and you have a
completely black screen. The final
step is to bring in the flash. Where
you prefer to position your flash and
what modifier you use is entirely up
to you, depending on the look you
want to achieve. | find | get great
results with a 60-inch reflective

I#\;;._'
umbrella (Figure 9). This is a great ‘.

piece of equipment that creates ~
beautiful light and | can use a peg
to close it down and control how

much light | want and where | want
it to fall (Figures 10 and 11).
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6. Again, after doing this a few times, experi-
ence will dictate what power level you use

for the flash. Until that time, just pick a power
level (1/4 power, for example) then take a shot
and see what you get. If you want more light,
increase the power of the flash in increments
until you get what you want. If the light from
the flash is too bright, simply lower the power
level in increments.

As a rule, the shutter speed controls the amount of ambient light that gets
through to the sensor and the aperture controls the flash power. But with this
technique, once you’ve set the shutter speed and aperture to give you a black
background, you really need to leave them alone and control the power of the
flash manually.

Because this technique requires the use of off-camera flash, you need to

have a way to trigger your flash. | use PocketWizards, which are the industry-
standard radio triggers. They’re reliable and work at ridiculous distances, but
they do have a price tag to match. There are lots of alternative ways to trigger
your flash, including using a simple sync cable to connect your camera to your
flash (with obvious limitations) or using an infrared trigger. Nikon users can use
their camera’s built-in flash to trigger another flash using the Nikon Creative
Lighting System. You can even get budget radio triggers off eBay that seem to
work just fine.

In summary, there are five steps for creating an invisible black background:

1. Set your camera to Manual mode.

2. Select the lowest ISO (200 or lower, if possible).

3. Set the shutter speed to the maximum flash sync speed
(around 1/250s or 1/200s).

4, Select an aperture (use f/5.6 as a starting point).

5. Bring in the flash.
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That, quite simply, is all there is to it. I've deliberately not gone into too much
technical detail to explain this because | want this to be a simple “how to”
tutorial, but if you want to know all the technical ins and outs of this technique,
I'll gladly pass on recommendations for books that will cover it.

A couple of things to note

1. If you’re using this technique indoors, be aware that the light from the flash
may bounce off of light-colored walls, which will light up the room and destroy
your black backdrop. My advice when using this technigue indoors would be
to restrict where the light falls by using a modifier such as a Honl Photo Speed
Grid or Lastolite Ezybox, or to close down your reflective umbrella.

2. If you’re using speedlights outside on a bright afternoon, you will have to
close down your aperture so much (to /22, for example) that your speed-
lights won’t be powerful enough to reach the sensor. The answer here is to
find a covered or shady area in which to photograph, or better yet, to wait for
the sun to ease off a little. This technique can be done in the middle of the
afternoon on a bright sunny day, but that would call for much more powerful
lighting, which would cost a lot more money.
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| used the same tech-
nique to create this
image, but | used two
lights instead of one.
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Dave Black
Photographer, Educator and Author

As a freelance photographer for over 30 years Dave’s work has primarily centered on the sports
industry for such publications as Sports lllustrated, Time, Newsweek and the award winning TV
show Sports Century on ESPN. The list of event coverage includes the Masters, Kentucky Derby,
National Football League, NASCAR and extensive work regarding the United States Olympic

Committee, Olympic athletes and coverage of twelve Olympic Games. Known for his creative use of lighting and
in particular with the artistic technique of Lightpainting, Dave’s portfolio continues to broaden into the commer-
cial and advertising industry, and with specialized lighting projects including work for the National Geographic
and their book Where Valor Rests, Arlington National Cemetery. He is one of Nikon’s “Legends Behind the Lens”
photographers and is a prominent instructor at a variety of workshops each year. His monthly website tutorial
articles “Workshop at the Ranch” attract more than 85,000 unique visitors monthly. In 2010 he released his highly
acclaimed instructional book, The Way | See It. To see Dave’s images, learn more about photography, or purchase

his book visit his website www.daveblackphotography.com.

This class is for any photographer beginner to advanced who wants to learn the
most creative photographic lighting technique ...come on, you can do this!

What’s in my bag for Lightpainting:

m 35mm DSLR camera that is capable of changing lenses,

m Short Zoom lenses (example: | like to use: 24-70mm, 16-35mm),
m Sturdy Tripod, and a Head Lamp

m LED flashlight (150 Lumens or more!)

NOTE: For big landscapes, | have used a 2 million candle powered Brinkmann
rechargeable spotlight for years but they are no longer in business...but any
hand-held rechargeable spotlight of 1-2 million candles of power will do nicely...
example: Today | use the Larson Electronics RL-85 ... 5 million candle powered
rechargeable spotlight. https:/www.larsonelectronics.com/p-1919-5-million-
candlepower-handheld-rechargeable-spotlight-100w-halogen-spot-flood-
57-lens.aspx

NOTE: Small pocket cameras or cameras that do not have Manual Exposure
capability or cannot change lenses are not suitable for making Lightpaintings

The word photography in the Greek means “light writing.” Simply said,
Lightpainting is the revealing of the subject from the darkness with light. In
general, Lightpaintings make use of long exposure times like 3 seconds, 10 sec-
onds, 30 seconds, 2 minutes, or more, while applying light to the subject.

Let’s begin with some basics and Lightpaint a small Still Life that
can easily fit on your kitchen table.

| will need a dark environment for my little subject so close the door, draw the
blinds and turn off the light after you compose the scene and focus on your sub-
ject (more about focus later in the article)
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| will use a Manual Exposure of which | have a basic starting exposure which
| begin many of my Lightpaintings with ISO500, 30 seconds at f8. This basic
starting exposure certainly does not work for every Lightpainting but it is a
good starting point for many of them.

During the 30 seconds exposure time | will use a small mobile light source (150
Lumen LED penlight) to illuminate the subject in the scene revealing it from the
dark with Lightpainting.

For my Still Life and LIVE model Lightpaintings. A small LED flashlight with
150 Lumens will do nicely. | use a small Stylus LED penlight (AAAA batteries)
made by Streamlight: http:/www.amazon.com/Streamlight-65018-Stylus-4-
Inch- Penlight/dp/BO0O008BFS5/ref=sr_1_5?ie=UTF8&qid=1431293035&sr=8-
5&keywords=stream+light+stylus+pro

First: | arrange my subject and compose the scene.

Then: | secure the camera on a sturdy tripod.

And: With the studio lights turned “on” | Auto Focus on the subject.

And then: | turn “off” the autofocus.

This is so the autofocus does not activate or “search” in the dark when | turn off
the lights, open the shutter, and begin to Lightpaint.

| use the Auto Focus (AF) back button on my Nikon camera. By simply releas-
ing my thumb from the AF button on the back of the camera it stops activation
of the Auto Focus operation. Or you can also simply turn OFF the AF switch on
the barrel of the lens or on the camera body.

| will use a Manual WB of 10,000 Kelvin when Lightpainting with any LED flash-
light. This WB setting helps add a warm color tone to the overall picture. And |
will also activate the Long Exposure Noise Reduction mode in the camera found
in the Photo Shooting Menu if the exposure time exceeds 30 seconds ... this
prevents any noise speckles from appearing due to the long exposure time that
generates heat inside the camera.

With my usual Manual exposure: ISO500, 30 seconds at f8.0

I’m now ready to turn OFF the room lights and make my first “TEST SHOT”
without adding any Lightpainting to the subject ...I just want to see if there is
any unwanted ambient light creeping in from a window or the door.

With my TEST shot complete, a dark or “Blank” image appears on the LCD screen.
Now I’'m now I’'m ready to add some Lightpainting during my second shot.
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Yellow Tail Fly ... Nikon D3s, ISO500, 30 seconds exposure at f8, Nikon
24-70mm lens, WB 10,000K, Manfrotto Tripod and 410 Geared Head, Stylus
LED penlight, SanDisk 32G Flash Card.

“If | want a picture to look interesting | only light part of it” ... like to apply
the light from off camera angles to create a dramatic lighting effect. My Stylus
penlight is only 10 inches away from most of my Still Life subjects. The light is
applied to the scene from a variety of angles.

The closer the light source is to the subject, the brighter the subject becomes.

Also said, the longer time | spend illuminating my subject the brighter the sub-
ject becomes. Too much light or too much time spent applying light can over-
expose portions of the image...and vice versa.

| try to keep the light source (Stylus) moving while applying the light, usually in
a swirling or brushing motion. This helps soften the transitional edges between
light and shadow, which is key in creating a painterly quality to the picture. You
are in effect “painting with light.”

My basic Manual Exposure setting of ISO 500, 30 seconds at f8 is a good basic
starting exposure, but it can vary depending on the intensity of your own flash-
light and the distance from flashlight to subject, and also how large is your
subject. Don’t give up, | sometimes make 10-15-20 Lightpaintings before | get 1
that I really like.
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Ballerina Thinking ...
Nikon D850, ISO500,
30 seconds at f5.6,
Nikon 16-35mm

lens at 35mm, WB
10,000K, Manfrotto
Tripod with 410 Gear
Head, Stylus pen-
light, SanDisk 32GB
Extreme Pro Flash
Card.

Lightpainting people
is a lot of fun and can
produce a very lovely
portrait ..as long as
the model remains
perfectly still during
the long exposure
time of 30 seconds.
My advice is to find a
very patient subject
to Lightpaint.

| used ISO500 and
my Stylus penlight
for this Lightpainting
of a Ballerina. |
Lightpaint the mod-
els face with the
Stylus from about 2
feet away and only for 2 seconds. Any longer time painting or any closer to the
subject with the flashlight and the model will probably blink, thus causing blur-
ring of eyes.

After | Lightpainted her face for 2 seconds, shoulders and torso for 3 seconds,
Toto costume for 2 seconds, leg and Ballet Toe Shoes for about 3 seconds (10
seconds total) ... Then | manually unfocused the lens about half way to infinity ...
| call this “Soft Focus” ... and then | continued Lightpainting the background out
of focus for about 5 seconds. | also used 2 colored LED flashlights in the back-
ground, Red and Blue to create a pink-violet color.

NOTE: It took about 15 accumulated seconds of time to walk around the
Ballerina applying the light from different angles, and walk to the camera to
unfocus the lens and then return to the ballerina. Factor in about 5 seconds to
“think” about where to apply the light ... all time added up totaled 30 seconds.
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Tufa Galaxy ... Nikon
D750, ISO6400, 20
seconds at 5.0, Nikon
16-35mm f4.0 lens,
WB 4000K, Manfrotto
Tripod with 410 Gear
Head, 2 million candle
rechargeable spotlight
(GOOGLE search 2
million candle pow-
ered spotlight work),
SanDisk 32GB Extreme
Pro Flash Card.

NOTE: For big land-
scapes, | have used a 2
million candle powered
Brinkmann recharge-
able spotlight for years
but they are no longer
available...but any hand-
held rechargeable spot-
light of 2 million candles
of power will do nicely.

Today | use the Larson
Electronics RL-85 ... 5
million candle powered
rechargeable spotlight.
https://www.larsonelectronics.com/p-1919-5-million-candlepower-handheld-
rechargeable-spotlight-100w-halogen-spot-flood-57-lens.aspx

Tufa Galaxy breaks the routine of basic Lightpainting with its unusual exposure
settings of ISO6400, 20 seconds at f5. The extremely high ISO and wide aper-
ture enable the Milky Way to be seen over Mono Lake.

While the exposure time of 20 seconds at f5.0 captures the Milky Way motion-
less, | add Lightpainting with my 2 million candle spotlight on them from my
OFF Camera location to the left.

My WB of 4000K keeps the sky a dark “deep space” blue while the warm col-
ored light from my 2 million candle powered spotlight added a warm tone to the

Tufa and grass.

Lightpainting is fun and creative...Thanks for joining me at PSW 2018
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Advanced Photoshop Tips & Tricks

With JULIEANNE KOST

To access instructor provided digital downloads, visit: photoshopworld.com/ notes
downloads. The password is; PSWDDOR2018193418.

Examples include:

* New Brush Preset Management in Photoshop CC

» Radial Paint Symmetry in Photoshop CC

¢ Four Ways to Select Layers in Photoshop CC

¢ Custom Keyboard Shortcuts for Photoshop CC

» Five Reasons to use Smart Objects in Photoshop CC
» Ten Helpful Shortcuts for Working with Layer Masks in Photoshop CC
* Four Quick Ways to Use Photoshop’s Fill Command
* The Key to Using Smart Guides in Photoshop CC

¢ Five Reasons to Use Smart Filters in Photoshop

¢ Three Ways to Quickly Zoom into Photoshop CC
 Five Tips for Working with Brushes

» Six Easy Ways to Select Colors in Photoshop

* 10 Tips for Working with the Layers Panel

* Eight Reasons to Use Layer Groups

¢ Three Tips for Photoshop’s Crop Tool
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Lindsay Adler

Portrait and Fashion Photographer

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion
and photography publications including Marie Claire, InStyle, Noise Magazine, Zink Magazine,
Rangefinder, Professional Photographer and dozens more. As a photographic educator, she is one

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and most presti-
gious events. A clean, bold and graphic style has become the hallmark of her work, whether shooting advertising
campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay
is renowned for her creativity and collaborating with designers and stylists in order to create fresh looks. An
author of four books, she is always working on new ways to share her passions and knowledge with others. Each
year she teaches to tens of thousands of photographers world-wide through prestigious events.

Part |

What is Color Grading?

Color grading alters or enhances the colors and tonalities in a scene to create
mood an impact. There is no “right or wrong” way to color grade. The color
and toning choices reflect the desired emotions or concept of the image.

Color Correcting vs. Color Grading
Color correction is typically aimed at removing a color cast or color tempera-

ture shift in an image to more accurately represent true colors in a photograph.

Color grading moves away from “correct” color and instead uses colors to
establish mood.

Learn from the Movies

Typically cinematographers (or in the movies) they capture visuals that are
lower in contrast, less saturation, and flat. The color, contrast, and tones are
adjusted after the fact to allow more flexibility. Often the orange/teal combina-
tion is used to create tension and energy.

Common Approaches
m Complementary Colors (one color in highlights, opposite in shadows)

m Analogous Colors (side-by-side on the color wheel)
m Temperature shifts (warm up, cool down).

Color Grading Plugins
m OnOne Photo Raw

m MacFun Luminar
m AlienSkin Exposure
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Part 2

Favorite Lightroom Tools
m White Balance

m Split Toning

m Local adjustments

m HSL (hue, saturation, luminance)
m Presets

Part 3

Favorite Photoshop Tools:
Selective Color (adjustment layer)
m Shift colors in shadows, midtones, highlights

Hue/Saturation (adjustment layer)
m Transform a specific color range

m Use the rainbow “color range” to more narrowly/broadly target colors, then
shift hue

Gradient maps (adjustment layer)
m Apply “color casts” to specific tones in a photograph

LUTS: Color Look Up Tables (adjustment layer)
m Formulas/Presets that apply a color and tone transformation

m Create your own or import presets

Blending Modes
m Diverse applicability but often to add selective contrast

m Favorite: black and white adjustment layer on soft light

Blend If
m Right click on adjustment layer > blending options

m Selectively remove effect off of highlights or shadow areas (better blending
or target specific tonalities in the photograph)

Luminance Masks (apply image to remove/apply to skin)
m On a particular adjustment layer, you can apply effect more/less to skin or
surrounding areas

m Image > Apply Image > Red Channel
m Invert Mask if necessary to apply to opposite areas in photograph
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The Art of Magazine-Quality Skin Retouching

With KRISTINA SHERK

Kristina Sherk

Photo Retoucher, Author

For the past 10 years, Kristina Sherk has been a high-end photo retoucher based out of Washington,
D.C. and is called the “picture whisperer” by some. She specializes in realistic retouching. She’s a
contributing educational author for publications like Shutter Magazine, Photoshop User Magazine
and Lightroom Magazine. She is also the author behind Photoshop Cafe’s Fashion Retouching
DVD. Her more reputable corporate clients include National Public Radio, Time Inc., XM Satellite Radio, Cotton Inc.
and most recently, Hasselblad.

How Skin Reacts to Light: The act of retouching skin is to fix impurities on a cli-
ent’s face that may distract the viewer from their features (i.e. eyes, nose, mouth)
a. What is ideal lighting for skin?
m Soft (less imperfections show)
m Butterfly lighting
b. What causes skin to photograph poorly?
m Harsh lighting
m Contrasty situations
c. Photoshop can help you mitigate imperfect lighting to create the illusion of
skin with less distracting elements.

Harsh Overhead Lighting  Diffused Overhead Lighting  Under/Villainous Lighting

Blemishes:
Batch Blemish Removal
m Create Folder “Blemishes”
m Create New Empty Layer; name “Blemishes”
m Patch Tool
1. Inside the healing brush fly out menu
2. Set to content aware
3. Structure = 7, Color = 0O
4. Check sample all layers
[-W N ] Adobe Photoshop CC 2015

# . 0 [ P [H  Patch: [Content-Aware = Structure: 7 [~ Colorig = ¥ Sample All Layers
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5. Circle a blemish, hold down shift key and continue to select more blemishes
6. Hover mouse over one selection; click and drag until you find a direction
that looks good for most of the points

Healing Brush tool

m New Photoshop CC 2015 Healing Brush added Live Preview as you
worked, but it made the final healed area look very blurry. 2015.1 added
diffusion slider.

m When we use a tool to remove a blemish, we want it to erase the blem-
ish but ALSO blend in the new skin color and texture with the surround-
ing areas so it looks like there was nothing there in the first place. When
retouching skin, a low diffusion (1-3) works better than a high diffusion
(4-7). Some examples are below:

Healing Brash: DilTusion |

Spot Heabing Brush Tool

INE2
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m This tool is smart but needs help from you

m Give this tool information that helps it make the right decision. If you're
healing a stray hair that is perpendicular to the hair line, make sure you
sample an area that shows this tool what you want the ‘fix’ to look like

m Aligned check box will lock the proximity between your sample area and
your area that needs fixing. Uncheck this box to fix multiple skin spots with
the same reference area.

m Sample: Current and Below: Do your blemish healing on an empty layer. It

keeps the file size down. By sampling current layer and below, it allows you
to heal blemishes on an empty layer

6'0 - E Mode: Normal %+ Source: Sampled Pattern: ¥ Aligned Sample: Current & Below =

Spot Healing Brush Tool
m Type: Content-Aware
m When using this tool on hair, extend healing section 1/4 inch past the end-
ing point, you think. Extend past general hairline. This helps the algorithm
make a better guess at what you want; it also helps avoid bleed.
m To heal on an empty layer, make sure Sample All Layers is checked

& - 3.5 ~ Mode: | Normal i Type: Content-Aware  Create Texture | Proximity Match ¥/ Sample All Layers (&

Clone stamp tool

m Generally use at 20-30% opacity or 100% opacity with a very small brush
size, depending on how in focus the image is

m Keyboard number keys quickly change tool opacity: 2 = 20% opacity, 7 =
70% opacity

m Shift + Keyboard number keys quickly change tool flow: Shift + 2 = 20%
flow, Shift + 7 = 70% flow

m Consider lighting variations when cloning, so it keeps with the shape of the
face/image

m Good to diminish the look of fine lines/wrinkles that you don’t want to
completely erase

m Fade your most recent stroke: (Shift+Command/Control+F) allows you to
fade the last brush stroke

L - - B BY Mode: TNomal = Opacity: 10% =1 gf Flow: 100% 5] (f  Algned Semple: GURSREBEOWTE )

Frequency Separation
Create two merge visible layers: Shift+Option+Command+E
(Shift+Alt+Control+E) TWICE
m Name the top layer Texture
m Name the bottom layer Tone
m Turn off visibility of Texture Layer
Select Tone layer and Gaussian Blur (Filter-Blur-Gaussian Blur)
m Your objective is to just slightly blur to get rid of texture.
Don’t go overboard.
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Select Texture Layer and choose Image - Apply Image
m For the Layer Section, choose Tone Layer
m For the Blending Selection, choose Subtract
m Scale: 2
m Offset: 128
m Press OK

In Layers Pallet, change Texture layer’s blend mode to Linear Light
Put Tone and Texture Layers in their own Layer Group.
m Name the folder Frequency Separation
m Make sure Texture lays above tone in the layer hierarchy.
m Test: Turn visibility of Frequency Separation Group on and off and you will
see no difference.

Fix Tone Problems: In Frequency Separation Group, create blank layer in
between Tone and Texture.
m Name Layer: Fix Color Here
m Use Healing Brush (set to sample “Current and Below”) to fix
color problems.
m You can also use regular brush tool or Clone Stamp to fix color problems.

Fix Texture Problems:
m Duplicate Texture Layer
m Change it’s layer blend mode back to Normal
m Rename the layer “Fix Texture Here”
m Choose Layer - “Create Clipping Mask” from the top menu
m Use healing brush to fix texture problems on this layer.
m REMEMBER: When using Healing Brush - Sample must be set to Current
Layer Only.

30 -acube

20 usguwe
Dodging and Burning

This is the act of creating the appear-

ance of a 3-dimensional shape on a

2-dimensional plane.

It’s also the act of simply creating
3-dimension where there is none.
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This is instrumental in creating a smooth canvas where the client’s features can
take center stage. Helps to even out the skin tone, giving the illusion of less
ridges and valleys in the subjects’ skin.

It’s similar to makeup artists using
makeup to contour.

Picking Dodge and Burn Colors
Selecting Colors:

m Black and white goes too far on
skin tones; black gets too saturated
and white loses too much color

m Select highlight and shadow colors
from the skin as a starting point

m Modify the sampled highlight and
shadow colors
1. Areas that are burned too much

can turn red, so add yellow hue
to the burn color
and decrease

saturation

2. Areas that are T
dodged too . = .Black
much can turn .. Highlight
yellow, so add g Shadow

red hue to the - Modified
dodge color .
and increase
saturation

Modified
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m Select highlight color for dodging
1. Brush tool
2. Click on the foreground color swatch box
3. Color picker > select lightest highlight on face
4. Drag the color slightly North and slightly East
5. Hue degree box - use down arrow key to nudge the color a little less
yellow and more red
6. Decrease hue value by 3 -5

L)

[ Cancel ]

Add to Swatches
|
Color Libraries

) Only web ColorsQyiginal Oe: (212 Slides 11 |%
Sample — Ko |%
Cibv #lioatoa | :

m Select shadow color for burning
1. Click the background color box
2. Color picker > select darkest color on skin
3. Click and drag South a little bit and drag it halfway West
4. Hue degree slider - use up arrow key to make the color a little less red
and more yellow
5. Increase hue value by 5 - 7

Cancel

Add to Swatches
Color Libraries

OL: |42
Ouls
%\ Ob:ls |
C: 50 |%
o5 | HueM:[ss |
(] Only Web Colors On: (e Slide (s |%
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Dodge and Burn Skin - Practical
m Create Group “Dodge and Burn”
m Shift+Command/Control+N for new layer dialogue box
m Name “Dodge and Burn Skin”
m Change blend mode from normal to soft light
m Check box to fill with 50% grey
m Brush tool (B key)
1. 10% Opacity (1 key), 10% Flow (Shift+1 key)
2. Err on the side of caution by starting with a lower opacity and flow and
building up if needed
a) You should NOT be able to see each brush stroke you make
3. Folds/Wrinkles are just a highlight next to a shadow
4. X key switches between foreground and background color
a) Brighten areas that you want to highlight; darken areas that you want
to diminish
b) If you change the blend mode of the layer from soft light back to nor-
mal, you can view the dodging and burning work that you did

Dodging and Burning Features - Practical

m Dodge and burn can also be used for detail areas like eye whites and lips

m Make the eyes and lips more three-dimensional

m Select the last dodge and burn layer

m Command/Control J to Duplicate layer

m Edit > Fill with 50% grey

m Move into new folder, named Dodge and Burn Detail

m Save the foreground and background colors (skin highlight and shadow
colors) for later use
1. Swatches dialogue box, Add to swatches
2. Name swatches D&B - dodge and D&B - burn
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Photography

ents Swatches

m
CEEEE

|,

N

Bl Create new swatch of foreground color
B Kristis Actions

ImagenomicPortraitPlugin
SharkPixel.com Essential ...

SharpenActions

m D key - switch back to default foreground and background colors; black
and white

m Paint with white on anything you want to pull forward towards the camera;
paint black on anything you want to push back

m If you change the blend mode of the layer from soft light back to normal,
you can view the dodging and burning work that you did

Dodge and

ggryRERRREN

Burn Details
> on Normal
Blend mode
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Visual Aids
These are layers that help exaggerate tonal and color differences in the skin so
they’re easier for your eye to see.
m Tonal Differences Visual Aid Layer:
1. Desaturating image will help you focus on the tonality differences with-
out getting distracted by the colors

2. Create New Layer “Dodge and Burn Visual Aid”

3. Fill with 50% grey

4. Change layer blend mode to Color

5. Lock this layer so you don’t do any retouching on this layer by accident

m Color Differences Visual Aid Layer:
1. Creating contrast between the red and yellow skin tones will show you
where you may need to fix skin color problems.
2. Create Black and White adjustment layer
3. Make sure the Preset is set to Default

Ibraric Properties

[ K3 Black & White

Preset: Default

'\@ Tint
Reds:

Yeliows:

Greens:

Cyans:

4. Pull red slider all the way down to -200 and take yellow slider all the
way up to 300

5. Creates contrast between red and yellow values in the skin tone

6. Change blend mode to Luminosity
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In this workbook, | wanted to provide you with some of the often disregarded notes
compositing principals in Photoshop. There are of course many more, but
these are the ones that most people never think about.

Perspective

In compositing, you can get everything right, lighting, color, shadows, and
extractions, but if the perspective is off, your viewer will immediately know that
something is off with your composite. They may not know what it is, but they
will have the feeling that something is not quite right.

Perspective is perhaps the most critical principle that you must learn and
implement when creating composites in Photoshop.

Let’s start discussing how perspective works with composites by simplifying
everything. This image plane contains a ground plane, represented by the grid,
and a sky which is above the grid.

Every composite that you work on in Photoshop will consist of these two ele-
ments. A ground plane and a sky. The most important thing to note these ele-
ments is where they meet.

The meeting point is known as the Horizon Line, and it becomes extremely
important in compositing as it will be your point of reference for all the images
and objects that you bring in.
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You may have heard that the horizon line is the eye level, and that is true. If
you were standing on this ground plane and you were looking off into the dis-
tance, the horizon line would be at your eye-level.

However, in a photograph, the horizon line is in line with the camera’s lens
when the photo was shot. The eye level of the camera.

This is extremely important because to make sure that your composites look
real, the perspective of all your elements need to match, they need to have the
same eye-level. In other words, the horizon lines of the different elements need
to match, or at the very least be near each other.

The graphic below shows a ground plane with two cubes. The cubes in the
scene really do look as if they are sitting on the ground because the perspec-
tive matches.
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One way of finding the perspective of an image is to follow the receding con-
verging parallel lines until they meet in the background.

In this graphic, the edges of the cubes create parallel lines that recede into the
background. When you follow the converging edges of the cubes until they
meet, you will see that they meet at a single point. This point of convergence
is known as the Vanishing Point, and it lays on the horizon line. Where the
ground plane meets the sky. That is the critical piece of information that you
need when you are compositing.

If you rotate either of these cubes, you would, of course, get a different vanish-
ing point, but that vanishing point will always end up on the horizon line, and it
will be in perspective.

When you are compositing, you will bring in elements, and you need to make
sure that the parallel converging lines end up on the horizon line, or close to it.
Sometimes, the perspective of your elements will be so different that they will
not work in your composite.
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In this example, we will use this cube to represent a different element from a
different photo that you want to incorporate into the scene.

Where can you place this cube within this scene? If you randomly select a spot,
you will notice that it doesn’t match the scene. The cube will seem out of place
because the perspective is off.

To make this cube match this scene, you must follow the converging lines to
find the horizon line and match its horizon line to the background image’s hori-
zon line.

To make the horizon lines match, move the cubes down so that its vanishing
point sits on the horizon line.

Once the horizon lines match, you can move the cube from left to right with-
out affecting the perspective.

In most cases you will not need a perfect match, if you are in a close enough
range, you will be able to fool the eye. But the wider the mismatch of the hori-
zon lines is, the less realistic the composite will look.

So far, we’ve seen images with a one-point perspective, but there is also Two-
Point Perspective and Three-Point Perspective.
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Two-Point Perspective

Two-Point perspective is very similar to One-Point perspective. The difference
is that when you follow the converging lines, you end up in two different van-
ishing points, both on the horizon line.

Vanihing Point Vanishing Poiot
) ]
: = . /

S e

You can find this kind of perspective on many kinds of photos including pho-
tos of buildings, where you stand right at the corner of the street, and you
can see both sides of the building.

Three-Point Perspective

Three-Point perspective is very similar to Two-Point perspective. The differ-
ence is that there is a third Vanishing Point above or below the horizon line.
This vanishing point does not sit on the horizon line.

In this example, the third vanishing point sits above the horizon line, but there are
two points sitting on the horizon line which helps you determine the perspective.

\
\':m.'.hfng Pom Vnm;hir;g Point
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An example of this type of perspective in a photo would be when you either
lookup up at a tall building from the street or looking down at a building from
a helicopter.

Just like with one-point perspective, the important thing is to find out where
the horizon line is to make sure that all the elements in your composites match.

Compositing Using Perspective

In the composite below, there is a problem with perspective. Even though the
mask, shadows, color, and almost everything else works, you still get the feel-
ing that something is off because of the perspective.

You can see the background’s horizon line on the top part of the image. Where
the ground plane (water) meets the sky.

This is what the model’s original photo looks like.

111




Making Realistic Composites in Photoshop

Photosho

a kelbvone

P

World

onference

With JESUS RAMIREZ

Notice that the horizon line, where the ground plane meets the sky, is much
lower. The horizon line is right above his knees. The discrepancy of perspective
is what makes the composite not work.

To fix this issue, you either need to move the background down or move the
model up so that both horizon lines match or are at least near to each other.

Atmospheric Perspective

To create a believable composite, you must learn to create depth by receding
objects into the background. The best way to create depth is by using atmo-
spheric perspective.

Much like perspective, and horizon lines, Atmospheric perspective is something

that beginners often disregard and makes their composites look flat and have
a cut-and-paste feel.

112




=< Photoshop\/\orld

° a kelbvone I conference

Making Realistic Composites in Photoshop
With JESUS RAMIREZ

How does atmospheric perspective work?
Atmospheric perspective or aerial perspective, as it’s sometimes called, is the
decrease in tonal range of an object as it recedes into the background.

In other words, the further away that something is from the viewer, the less
contrast it will have between its darkest and lightest point. The Density in the
air causes atmospheric perspective. Air contains water particles, mist, smog,
and many other things.

As the distance between you - the viewer - and the object increases, the den-
sity of the layer of air also increases and the object starts losing detail, satura-
tion, and contrast.

Look at the sphere closest to us. Notice the contrast between the darkest and
brightest point and the wide range of tonal values. As the spheres recede into
the background, the contrast and tonal range decreases.

Another way to think about it is by thinking of values. Objects near each other
in the Z axis have similar tonal values or similar contrast.

When you are compositing, you should try to match the values of surrounding
objects to display your object’s depth within the image.

For example, if you wanted to composite this tree onto this photo, you would
need to match the atmospheric perspective to recede the tree to the appropri-
ate depth of the scene.
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One way of doing so
is by using a Layer
Style. Right-Click on
the layer and select
“Blending Options”
then click on Color
Overlay. Double-click
on the Color Swatch
to bring up the Color
Picker and select a
blue-gray that is simi-
lar to where the tree
is sitting on the cliff. Then reduce the Opacity until the tree matches the
surface that it is sitting on.

Once the tonal values match, the composite will seemm much more realistic.
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Shadows

Shadows are not simply a black shape over an image. They also have perspec-
tive, and they are not pure black. Look at the photo that you are working with
and look at the shadows found in it. They are never black!

There are many ways to create shadows in Photoshop. One of my favorite tech-
nigues is to use an Exposure Adjustment Layer because it allows you to easily
adjust the darkness of the shadow and it uses the colors found in the image.

Start by creating an Exposure Adjustment
Layer and reduce the Exposure to make the
entire image darker.

Then click on the Layer Mask and press Ctrl
| (Mac: Command 1) to invert. This will make
the Layer Mask black and hide the effects
from the Exposure Adjustment Layer.

Then, with the Layer Mask selected, you
can paint with white to reveal the darkening
effect which will create your shadow.

If you need to adjust the darkness of the
shadow, then adjust the Exposure slider.
Remember to look at the direction and
darkness of the other shadows of the scene
and use them as a reference for the shadow
that you create.
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Reflections

Reflection can be difficult in Photoshop. You cannot flip a duplicate of your
object vertically and expect a good reflection. You need to make sure that the
reflection also has the same perspective as the rest of the composite.

!

The first step is to flip your object vertically. But that is not the final step! You
need to break it apart into different pieces and adjust them individually.

Think of your car (object) as a cube. Each face will make a new layer.

You can use the Lasso Tool (L) to select each face and cut it into a new layer
by pressing Ctrl Shift J (Mac: Command Shift J).

Once you have all the pieces in individual layers, you can distort them individu-
ally so that they follow the perspective of the scene. Distorting one single layer
could be very difficult, but if you separate the pieces you can make much more
realistic distortions.

|
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After you are done, you can place all the pieces of the reflection into a group
by pressing Ctrl G (Mac: Command G) and reduce the opacity to make it
more realistic.

Saturation

Just as with contrast and luminosity, having two elements in a composite that
have vastly different saturation levels can lead to an unrealistic composite. For
a visual representation of how much saturation there is in an image, you can
create a Saturation Map, then use the Hue/Saturation Adjustment layer to con-
trol the saturation of your elements.

Start by creating a Selective Color adjustment layer (Layer > New Adjustment
Layer > Selective Color) and name it “Saturation Map.”

In the Properties panel, click on Absolute. From the “Colors” drop-down select
“Reds.” Drag the Cyan, Magenta, and Yellow sliders to the far left, which will
result in a value of -100% for
each. Go back to the “Colors”
drop-down, and repeat this
process for the Yellows, Greens,
Cyans, Blues, and Magentas.

Then select “Whites” from the
“Colors” dropdown and move
the Black slider to the far right,
which will result in a value of
+100%. Repeat this step with both the Neutrals and Blacks.
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Once you’ve cre-
ated the Saturation
Map, you will see

a black and white
image. Anything
that is white is
highly saturated,
while anything that
is black contains no
saturation. The dif-
ferent levels of gray
represent various
levels of saturation.

In this composite, the model is much brighter than the background, indicating
that she has far more saturation. For a more realistic composite, you need the
saturation levels of both the foreground and background to be similar.

Use Hue/Saturation Adjustment Layer to solve this issue. Set the Blending
Mode to “Saturation” and clip the Hue/Saturation Adjustment Layer to the
model layer by pressing Ctrl Alt G (Mac: Command Option G).

Then adjust the Saturation and notice how the brightness of the model will
change. Try to make the entire image match in darkness and brightness.

After you are done, disable the Saturation Map by clicking on the Eye icon,

and you will see that the model is looking more like she is part of the back-
ground and not a separate element.
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Dave Cross
Certified Guru and Technical Trainer

For 25 years Dave Cross has been helping photographers and creative professionals get the most
out of their Adobe software. Dave has a Bachelor of Education, is an Adobe Certified Instructor
and is a Certified Technical Trainer. Dave has taught for Adobe, at Photoshop World, the Texas
School of Photography, the Santa Fe Workshops, at ShutterFest and is a frequent instructor on

CreativelLive. He offers online training at online.davecrossworkshops.com. In 2009 Dave was inducted into the

Photoshop Hall of Fame.

In this class we’ll be exploring various ways of moving files between “the big
three” - lllustrator, Photoshop, and InDesign - with a particular focus on non-
destructive methods. Before we go too far it’s important to note that one of the
advantages of working with these apps is that you can use the native formats of
.ai and .psd and that’s what’s going to allow us to work non-destructively.

Illustrator to Photoshop

When you move lllustrator artwork into Photoshop you have several options:
copy and paste, Place, and Open. As you might expect, each method has its
advantages and disadvantages.

Open in Photoshop
When you use File>Open Ampart POF

Select Page Options

and click on an lllustrator O rages Oiages (Sdana

file C.ai) it is treated as a
Vﬂ v Anti-alased
PN IAURAS Image Size: 12.7M

PDF file, resulting in a dia-
widkh: (2479 | {pets W
= —

Crop Ta ]lcun;hngla: '

Radin's

log box where you choose
the size, resolution, color Helghe: (1765 | | hels

mode etc. f(nmualn'vmpomm,‘ -
Resolation: {300 | Pixals /inch :[
Mode: |RGB Coloe 7|
The key things to remem- £t Depeh: [ sba 2|

ber about using the Open

command are:

1. The Vector artwork is
rasterized, meaning it
can no longer be made larger without loss

I Suppress Warnings
I of 1 page(s) selected

e R
Thambnad Sire: | Large Cancel |

Hr=cden's

of quality.
2. Once the file has been opened in
Photoshop there is no longer any rela- //’
i

tionship with Illustrator or the original file.

| suppose that this last issue can be both
good and bad - at least you can’t overwrite
the original file by mistake, but personally
| prefer the option to preserve the Vector
nature of the file and the ability to edit it in
[llustrator. The other two options offer that possibility.

REUESS AU EREASNT
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Place in Photoshop
Using File>Place in Photoshop will result in a Vector Smart Object. That means
that a two-way editing street is created between Photoshop and lllustrator: edit
the file in lllustrator and it will update in Photoshop. However this method does
come with one big potential “gotcha” we’ll talk about in a moment.

Open As Smart Object
When you use the Place command a T o
dialog box opens that really is just to St ; C;wm T
confirm that it is the correct artwork Hed's sk
(since there are no options to choose). G /%f’

Then you resize the artwork, hit Enter, L
and a new layer is created. That layer

is a Vector Smart Object that displays

the name of the file you placed. That is A 7
very important to note, since it means Thumboall Size: | Large ] et |
that you are linking to the original art- )
work. One of the advantages of using

Vector Smart Objects is
that you can double click
on the thumbnail to return
to lllustrator to edit the file:
make changes, save it, and
the changes are reflected in
Photoshop.

HOWEVER, in the case of a
placed Vector Smart Object,
when you save the changes you
are saving over the original file.
As you can see here, when you
edit the file in lllustrator it is the
original file.

As long as you understand that,
you may choose to Place, but you
have to consider the implications RESTAURANT
of saving your original file - that

may be used in other documents.

If you want all the linked graphics to change, this works well, but if you don't....
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Copy and Paste

The biggest difference between this
method and placing is that you are
adding a copy of the artwork, not the
original file. You still have the ability to
double click on the thumbnail to return
to lllustrator to edit the file, but the
original lllustrator file is unaffected. The ESTAURANT
process is pretty simple: select and = B
copy the artwork in lllustrator, switch

e

to Photoshop, and paste. You'll be —
presented with a dialog offering sev- g::::‘”i“' e
eral options: in this case (and most o

cases) choose Smart Object. O shape Layer

After sizing and pressing enter, the layer is created, but in this case is named
Vector Smart Object. When you edit that file in lllustrator the file name indicates
that you are editing a copy. As before, make changes in lllustrator, save, and
when you return to Photoshop the Vector Smart Object layer will update.

Keep in mind that you can perform most layer functions such as Opacity, Blend
Modes, Blend if sliders, etc., and still preserve the lllustrator editing ability.

TIP: Although you can transform a Vector Smart Object, it cannot be warped.
As odd as it sounds, convert the Vector Smart Object to a (Photoshop) Smart
Object and then you can warp it.
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Examples:

Use symbols in Photoshop

This is probably the simplest example since it requires very little knowledge of
[llustrator: just find an existing symbol and copy and paste it into Photoshop. In
[llustrator go to Window>Symbols, choose
one of the libraries, and drag the symbol
into the artboard. Copy and paste into
Photoshop to create a Vector Smart Object.

To edit the artwork, double-
click on the thumbnail

to return to lllustrator.

With symbols you'll
probably have to go to
Object>Expand to be able
to work with the “pieces”
of the artwork. Once you’ve
made any changes, save
the file, and it will update in
Photoshop. There are lots
of options in the Symbol
Libraries.
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Make a custom shape
One of the reasons to copy ., .
and paste from lllustrator is

to create a Custom Shape
that becomes “built-in” to /{ };\ ,/*

Photoshop. This only works

- J
with Illustrator artwork that is ixh S

| PHO TOGRAPHY |
one color and where any type G L 4 Damm.'

is converted to outlines.

This time when you paste in Shpailais

Photoshop, choose Path. Then from
the Edit menu choose Define Custom
Shapes and name the shape.

[ Cancel |

Name: lSwans loga

Atk
SN |

From then on you can add the logo

PHOTOGRAPHY

And because it’s Vector, you can resize
without returning to Illustrator.

Mask edge examples

Another simple way to “borrow” from
[llustrator is with the Brush librar-

ies. From Window>Brush Libraries
choose one of the libraries such as
Artistic>Artistic ChalkCharcoalPencil.

Drag one of the brushes onto the artboard and then copy and paste into

Photoshop. In this example | pasted four different brushes that | scaled to use
as edges on a masked photo - some of the edges | combined several brushes
in lllustrator to create a more unusual shape. Once | had the four Vector Smart
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Object layers | combined them into one Smart
Object so that it would be easier to treat the four
layers as one layer. To edit any of the four edges
| just have to double-click
on the Smart Object to
access a separate docu-
ment that contains the
four Vector Smart Objects
- which | then double-click
to edit in Illustrator.

Here’s a slight variation to make a cool edge for your
photo, starting with a basic rectangle in Illustrator.

Draw a rectangle and click
on the Stroke indicator. Then
: click on a brush from the
— Brush Libraries that will add
lg " an unusual edge. In this case |
(@™ W

used a watercolor brush.

Copy and paste that into Photoshop to create
a layer. Select that layer and copy it. Hold down
Option (PC: Alt) and click on the Layer Mask to view

the contents, then paste
onto the mask. Hide (or
delete) the Vector Smart
Object to see the result.
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Define a brush

Another use for the lllustrator brush Libraries is to use as a brush in Photoshop.
In lllustrator drag a brush onto the artboard from a library. Copy and paste into
a Photoshop document as a Smart Object. Then from the Edit menu choose
Define Brush. Now you can use this brush in Photoshop with any tool that uses a
Brush shape: Brush, Clone, Mixer Brush, etc.) Use it to create interesting borders,
to paint a cool mask with the Mixer Brush, etc.

Photoshop to Illustrator

Since you can open and place native Photoshop documents (.psd) into
[llustrator, this means you can include transparency when you use the file
in lllustrator. Another common practice is to “borrow” custom shapes from
Photoshop to use as building blocks in lllustrator artwork.

Open In lllustrator
" When you open a psd file in lllustrator a dialog box
opens that offers a few options. As we’ll see later, if
your psd file includes Layer Comps you can choose
which comp you want to use. Otherwise you can
Convert Layers to Objects - note that will make
the text editable
“where possible.”
In this example the
text can be edited
but the shapes are
i v v not editable vec-
VECTOR PHOTOGRAPHY tor objects.

If the layers in the psd file are shape layers then when you open the file in
Illustrator and choose the option to Convert Layers to Objects, the shapes will
be editable vector objects. Saving the file will result in an Illustrator (.ai) file with
no connection to the original Photoshop document.

Or you can choose to Flatten Layers to a Single Image - often a good choice
where there’s no need to edit anything and you want to preserve the look of the
original psd file.

design
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Place in lllustrator

As | mentioned earlier, if you create transparency in Photoshop it will be carried
over into lllustrator. First create a Layer Mask in Photoshop and save the docu-
ment. Then in Illustrator use File>Place, making sure that both Link and Show
Import Options are checked. If the psd file contains Layer Comps the Photoshop
Import Options dialog lets you choose which comp to use (as we’ll see shortly).
In this example the dialog does not appear so we can add it into our document.

Qo8 - Poce
REENERD  CRC MR BECY
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[§ Documents 0 ostes
£ Box Documents & 030¢
(B3 Creative Cloud Files = Q99
& on_Us & 02Bjeg
on & 027
MDA - 026y

-

Enasie: | Al Readable Documeess _ i
Munk O Template Beplace  (V Shew import Optiens

To make the placed
photo only appear within
the postcard use a
Clipping Mask: copy the
postcard shape, move it
above the placed photo,
and from the Object
menu choose Clipping
Mask>Make.
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To edit the original psd file, you can either use the Links
panel or with any tool active hold down Command and
Option (PC: Control and Alt) and double-click on the
placed graphic. That will open the file in Photoshop
where you can make a change such as lowering the
opacity of the layer.

Save the file and when you return to
[llustrator you’ll probably see a dialog
indicating that a file has been modified:
click yes to update the file.

Note: To avoid this dialog you can choose
to change the preference for this func-
tion: go to the lllustrator Preferences>File
Handling & Clipboard and change the
Update Link setting to Automatically.

After clicking yes, the placed Photoshop

document is updated.
| Praferances
This is a great way to
combine photographic
elements from Photoshop
with the graphics capa-
bilities of lllustrator.

As mentioned, if your
Photoshop document
includes Layer Comps,
when you use the Place
command or File>Open,
the Photoshop Import
Options dialog appears. Here you can choose which Layer Comp you’d like to
use when the file is placed - this way you can change the appearance “on the
fly” as you are placing the document.

Note: In order you switch to a different Layer Comp you have to re-link the
placed file so that the Photoshop Import Options dialog reappears.

What about Copy and Paste?

Although you can Copy from Photoshop to lllustrator, this creates an embedded
object that is very difficult to edit - it certainly does not have any of the advan-
tages of Placing. As such, it’s not recommended.
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Photoshop shapes

Ironically, lllustrator doesn’t come with s f ) WY
any basic shapes that you can use in your ) S U U S

artwork (although technically you could
use some of the

symbols) but

Photoshop does.

auN

N oA
)

bt 4 MWEX~® \
In Photoshop, : ‘ K RBAT IS * s &
choose the VAN KSR LYYV

Custom Shape tool (1 P——HEtdHE\\\

and then take a
look in the Custom
Shape Picker.

selected. Hold down Shift and drag out
the shape to make a path.

Copy the path, switch
to Illustrator and paste
into a document. In
the dialog choose
Compound Shape.
Now you have a fully editable path that you
can use in any way you want.

By the way, this also works with any Path

NN\ BE S kW e
Hue< il ‘
I% G e W B W

R e

X NACEEE T3 2+ 10
Choose a shape and make sure that in the * 0.0*.QOJQ 09
far left of the Options bar you have Path O#CBOAARX)5@0

mO 7t sRAVT 2%

Export Pachs ta file

you have created in Photoshop - with one
slight variation: after creating a path, go to
File>Export>Paths to lllustrator. In the dialog

Paths: | Work Path

make sure that the correct path is chosen and click OK.

Note: when you open the exported path in [
[llustrator it will have no Fill or Stroke.

Live Image Trace

Although it’s a little more unusual, here’s

an interesting concept: place a photo from
Photoshop to Image Trace in lllustrator..with
the option of updating the photo to get dif-
ferent trace results. Huh? Place the Photo
into Illustrator and in the Options Bar use
the pull down menu beside Image trace to
choose a preset.
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If the results are not exactly what you had
in mind, hold down Command and Option
(PC: Control and Alt) and double-click on
the placed graphic to edit it in Photoshop.
Make a change, save it, and when you return
to lllustrator the Image Trace will be redone
using the altered image.

Photoshop to InDesign

For the purpose of this class we’re not
going to talk about bringing lllustrator
graphics into InDesign except say that you
can, and as editable .ai files. When you place
an .ai file into InDesign you create a similar
kind of two-way editing street we talked
about with lllustrator and Photoshop.

There are also some similarities when you take Photoshop files into InDesign.
Although Copy and Paste will work, there is no link - or direct editing path -
between Photoshop and InDesign. Therefore the best choice is to use the Place

Y

'y (V)
transparency, it will work in your ' |
parency v Ak | I\

command. Similar to lllustrator,
InDesign supports transpar- ‘
ency, so if your .psd file includes o

InDesign document.

DSC_2059
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To edit the placed file back in Photoshop, you can either use the Links panel,

or with any tool active hold down Command and Option (PC: Control and Alt)
and double-click on the placed graphic. That will open the file in Photoshop
where you can make any editing changes you want. Then save the file and it will
update in InDesign.

Image Import Optians (rodgern prdd

If your Photoshop document
includes Layer Comps, make sure
that in the Place dialog Show
Import Options is checked. That
way you'll see the Image Import
Options dialog, in which you can
choose which Layer Comp to dis-
play when the image is placed.
Once the image has been placed
you can change - with a live pre-
view - to any other Layer Comp
in the Photoshop document. Go
to the Object menu and choose
Object Layer Options. In the dialog
(with Preview checked) choose
any Layer Comp to see the results
on the page. And this also works
with layers: just show or hide lay-
ers and see instant results.

Obirct Layer Opsions

Objpcx Layer Options

—HOTOCAAPHY

Primien Sanice P

This is a wonderful way to be able to experiment without having to return to
Photoshop to make a change.

Note: Any time you use the Place commend you are creating a link that uses the
name of the file and its current locations, so if you move, rename, or delete the
placed file, the link will be broken and you’ll have to re-establish it. It’s also worth
noting that InDesign (and Photoshop as of the CC
2014 release) has a Package command that will bun- s
dle together the document and any linked objects.
The Links panel will indicate any out-of date links.
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Camera Raw Smart Objects

Adobe Camera Raw has a great option that creates a two-way editing street
between ACR and Photoshop - and in effect between ACR and Illustrator or
InDesign. First you have to open a Raw file to open ACR, and then click on the
Workflow Options “link” at the bottom of the window. In the Workflow Options
dialog, check Open in Photoshop as Smart Objects.

This creates a two-way editing street between ACR and Photoshop: adjust in
ACR, open in Photoshop, double-click on the thumbnail to edit in ACR again. As
always, the thumbnail in Photoshop indicates that the layer is a Smart Object -
in this case a Camera
Raw Smart Object.

Photoshop

Open in Photoshop as Smart Objects

Where this gets even more
interesting is when you
Place the psd file contain-
ing an ACR Smart Object
into lllustrator or InDesign.
Doing this means that -
through one extra click

- you are accessing ACR
from within lllustrator or
InDesign. In this example
the psd file includes a
Camera Raw Smart Object
with a Layer Mask.

The psd is placed into
InDesign with the Layer
Mask creating a transparent
background.

DSC_2059
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If after positioning and resizing the placed file you decide that you want to edit
the ACR settings, hold down Command and Option (PC: Control and Alt) and
double-click on the placed photo to edit it in Photoshop. Then double-click on
the Smart Object thumbnail to edit in ACR. Click OK to return to Photoshop
and then save the document so that it will update in InDesign.

It’s easier than it sounds! And the exact same process works when you place
into lllustrator.

L Camers faw 0.1 = MNbkon D00

AR ROB (%03 L et U by 2802 05,3800 300

Libraries

One of the best new features added
to Creative Cloud is shared libraries.
This offers a really interesting (and
easy) way to share elements between
Photoshop, lllustrator and InDesign. In
any of the applications you can drag
into the Library different elements and
then access them in the other applica-
tions. For example, in lllustrator, select
and drag a logo into the Library panel,
jump to Photoshop and drag the logo
into a Photoshop document. And from
then on, Illustrator does not have to be
open for you to access the logo.
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Appearani Graphic St Libraries

Logos & Colors v

To add a graphic element to the Library Graphics
in lllustrator, select the graphic(s) and
then either click the first button at the
bottom of the Libraries panel (The “Add
Graphic” button), or drag the selected
graphics into the Library. Then you can
rename the graphic if you wish.

Luxurious

As long as you are signed in to your
Creative Cloud account, within moments
you will see and be able to use the logo
in Photoshop and InDesign.

ke Color € CC Libraries

Logos & Colors v =28

Graphics

With graphic assets you can simply drag
from the Library panel into a document.

Libraries can also include assets that are
specific to an application, such as Layer
Styles and Brushes in Photoshop, as well
as assets used by all apps including Colors,
Color Themes, and Text Styles.

Assets can also be added to a Library using
the free adobe Capture CC mobile app.
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How to Create The Hottest 2018 Design Looks

With SCOTT KELBY

To access instructor provided digital downloads, visit: photoshopworld.com/ notes
downloads. The password is: PSWDDOR2018193418.
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Create and Update Your Portfolio with Adobe CC

With TERRY WHITE

s

Terry White
Worldwide Design and Photography Evangelist - Adobe Systems Inc.

Terry has been with Adobe for over a decade. He has extensive knowledge of Adobe’s Creative
Professional product line. In his current position, he leads the charge in showing customers
Adobe’s Creative Solutions around the globe. Terry has been active in the industry for over 25
years and is the founder and past president of MacGroup-Detroit - Michigan’s largest Macintosh
users group and columnist for Photoshop User magazine. He is also the author of “Secrets of Adobe Bridge”,
“InDesign CS2 Personal Seminar” and co-author of “The iPhone Book” and “InDesign CS/CS2 Killer Tips.” Terry
is a key presenter at major industry shows around the world. Check out his extensive video tutorial collection

on YouTube - terrywhite.tv; His blog at terrywhite.com; Follow him on Twitter @TerryLWhite and Instagram @
TerryLeeWhite; Like him on Facebook: http://facebook.com/terrywhitefans.

Having an up to date online portfolio can mean the difference between getting
work or not.

Creating an online portfolio is usually not the problem. Keeping it updated is.
It’s a simple fact that the easier something is to do the more likely you are to
do it or keep doing it. If you’re a Creative Cloud member then you have three
ways of having an online portfolio as part of your membership. You can use
the newly improved Adobe Portfolio. This is an awesome web-based tool to
build and maintain your portfolio. You can use Adobe Muse CC to build a com-
plete website from scratch. This, of course, can be customized to your heart’s
content. You can have has as many gallery pages as you want. Lastly, you can
publish web galleries via Adobe Lightroom or use Lightroom Mobile to create
web galleries of your images.

Adobe Portfolio

Step one: Go to myportfolio.com

Beautiful portfolio
websites, free with

Creative Cloud
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Step two: Sign in with your Adobe ID if you’re not already signed in.
Step three: Click the Get Started button near the bottom left.

Step four: Choose a layout to start with.

. Adobe Poctiolio Oieview  Layoutt Teamphes  Priceg

Consider our layouts as the foundation
to building your own unique Portfolio

Designed with you ané yoor projedts inmund, Portfolls is sdeal for sharing feoen aty feld: an,
Huxtrition, photography, graphec deuigry, Isihion, acchiteciuse, mabian graphics of web devign

Matthiss

Saware cvers sl bt iderestiog Crgs of your
WO W & sl it g et wertcad
Navigaen

Step five: Customize the Masthead with a background image and logo if
appropriate.
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Step six: Add your first project/gallery from your Lightroom mobile images.

Ugpload Filos '

Step seven: Rearrange the images in the order you want.

Step eight: Continue Reorder Project Content
to tweak the other
areas of the page to = " image
your heart’s content.

Text
Step nine: Preview TR TR0 NRRRR AL 2 50
and Publish the page. b
At any time you can
now replace images
or add new images
or project whenever
you like.

Image

Image

Image

Image

Save New Order
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NEW Lightroom Integration and it’s what I've been waiting for!
If you use Lightroom CC or sync your photos via Lightroom Classic CC to
Lightroom Mobile then you will be able to EASILY add those albums/collec-

tions to your Adobe Portfolio.

Step one: Once you’ve got your portfolio layout established click the manage
content (folders icon) on the left side.

Step two: Click the big plus sign to add a new Lightroom gallery.

Step three: Once the window opens you can choose any one of your albums/
collections.

Step four: Give it a few seconds and the new gallery from Lightroom will appear.

Step five: Whenever you update this album/collection in Edit Page Tide
Lightroom you can come back to myportfolio.com and update B Shug
it here. Just click on the Manage Content icon again. Duplicate Page

Shaw in Multiple Galleries

Add Page Password

Step six: Click the gear to the right of the Lightroom gallery
you wish to update and then click Reset from Lightroom.

Hide In Navigation

View Page

Step seven: Close the manage content window. R s ki
| M Share on Beharce
Step eight: Click the Update Live Site button on the right. Detn Poge

Adobe Muse CC
While we don’t have the time in this class to do a complete Muse lesson, | will
cover the options for photo slideshows.
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Step one: Create or open an existing Muse website.

Step two: Create a new photo galleries page for the site.

Step three: Drag a blank slideshow from the widgets panel on to your page.
Step four: Add images to your slideshow.

Step five: Set the options for your slideshow.

Adobe Lightroom CC

You can use your Lightroom collections as images portfolios on the web via

Lightroom mobile or the plug-ins from The Turning Gate (theturninggate.net).

Step one: Put your photos in a collection representing one of your portfolio
categories (i.e. Landscapes Portfolio).

Step two: Arrange them in the order you want them in.

Step three: Start Lightroom Mobile syncing if you haven’t already been using it.

Step four: Enable the sync checkbox in front of the collection you created in
step one.

Step five: Make the collection Public (in the upper right corner of the
Collection). This will generate a custom URL to this specific gallery on the
web. You can either share it as is or add it to another website such as the one
you’ve created in Muse.

Copyright: Terry White
Website Info: terrywhite.com
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Lindsay Adler

Portrait and Fashion Photographer

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion
and photography publications including Marie Claire, InStyle, Noise Magazine, Zink Magazine,
Rangefinder, Professional Photographer and dozens more. As a photographic educator, she is one

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and most presti-
gious events. A clean, bold and graphic style has become the hallmark of her work, whether shooting advertising
campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay
is renowned for her creativity and collaborating with designers and stylists in order to create fresh looks. An
author of four books, she is always working on new ways to share her passions and knowledge with others. Each
year she teaches to tens of thousands of photographers world-wide through prestigious events.

Part 1: Plan

Concept:
m What is this shoot about?

Questions to Answer:
m What magazines are you aiming to publish in?

m What are key visual or stylistic characteristics of your goal publications?
m What season are you shooting for?
m What are the upcoming themes and deadlines?

Creative Team
m The people on a photo shoot that help bring the concept to life. This
includes hair, makeup, wardrobe, manicurist, prop stylist, or anyone else
involved in the process.
m Where to find them:
v Instagram and social media
v modelmayhem.com
v Publication research
v Creative Agencies
v Schools, academies, local salons, local boutiques, cosmetic counters

Mood Boards

m A mood board is a collection of images based upon a theme that helps you
visually explain the direction of a shoot. Typically it conveys the overall mood
of the shoot as well as direction for hair, makeup, wardrobe, and any other
pertinent information to communicate your concept.

m Also known as a vision board, inspiration board, concept board

m Images on the board typically are not your own but instead gathered from
online resources including Pinterest, Instagram, etc.

m A mood board is typically presented to a creative team to help them prepare
for a shoot. It may also be presented to a publication to communicate the
plan for your shoot, and ideally receive a commission.
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Models
m ModelMayhem

m Social media

m Agencies
v New faces in need of photographs, exposure, experience
v “Development models” or “new faces”
v “Package” of girls

Terms to Know

m Pull Letter: A magazine provides a pull letter to help you (and your wardrobe
stylist) get better clothing and creative team. The publication affirms that
you are shooting for them and to lend you the clothes you need to complete
the shoot.

m Commission vs. Submission: Submission you are shooting and then submit-
ting (with hopes of being published). Being commissioned means a maga-
zine has already expressed interest in your shoot concept and plans on pub-
lishing you in their magazine.

m Tears/ tear sheet: The pages of your work in a publication (whether digital
or physical). Editorials are typically shot in exchange for a “tear sheet” (aka
being featured in the magazine).

m Editorial: Usually 5-6 different looks on a theme. Up to 12 looks depending
on the publication. Should either be a change in hair/makeup or in wardrobe
depending on if it’s a beauty shoot or fashion editorial.

Part 2: Shoot

Other shoot considerations
m Permits, Insurance

m Gear rental
m Food/Catering

Call Sheet
m List of creative team and contact info

m Call times: when each person should show up

m Wrap time: expected end of shoot

m Schedule of day: plan at least 2 hours more than you think you need!
m Addresses/location

Tethering

m Lightroom or CaptureOne
m TetherTools Tether Cable (or other solution)
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Barter and Trade:
m Work in exchange for photographs

m Approx 2 retouched “high res” images per look to compensate team
m Portfolio building (not commercial)

Part 3: Publish

Who to Reach out to:
m Photo Editor

m Editor in Chief
m Assistant Editors

What to Send:
m Low res jpgs (retouched)

m PDF or jpg layout of favorite shots
m Creative team credits, credits of designers/makeup
m Link to high res (potentially)

When to Send it:
m Send just before 9am (their time zone), or not over a weekend

m In advance of deadlines

m Right of First Publication: Don’t publish elsewhere or online until magazine
has come out

Research of publications:
m http:/bit.ly/lapublished

m Instagram
m ISSUU
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Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife.

An award winning commercial photographer based in Manchester England and working
Internationally, his work is often described as both creative and dramatic. Tim works internation-
ally with many high clients across the globe such as Jaguar Land Rover, Peugeot, Mercedes and
Morgan as well as shooting some of the worlds most iconic brands such as Lamborghini, Aston
Martin and Ferrari in the UK and Europe to Dodge, Chevrolet and Mustang in the US. Over recent years he has also
broadened the AmbientLife brand to include other transport related work such as HGV Truck and large vehicle
photography, Aviation and aircraft work, engineering and logistics. Tim is a critically acclaimed photographer whose
work has spanned both commercial and advertising clients for over 11 years. Over the past decade AmbientLife
have worked with a who’s who of automotive royalty, from Jaguar, Aston Martin and beyond. Tim’s work is highly
sought after, and this is driven also by his string of awards including British Commercial Advertising Photographer
of the Year, and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words | live by in my Business:

“Your Professionalism is your Brand

Your Personality is your business card

How you make your clients feel is your Trademark”
- Tim Wallace

Having a great collection of work behind you is always a good feeling but it has
no value to you whatsoever if that work is never seen by the right people. As
professional photographers our business is ‘photography, taking pictures for cli-
ents and gaining the opportunity to do that by getting those all important com-
missions in from the ‘people’ who make those choices and decisions.
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Before we look at anything else there are a few things that we need to consider that
are really 101% crucial to having the right mindset behind how we approach this.

The first thing to consider is just who are those ‘people’ that we are trying to get
our work in front of, where are they from, what are they looking for, and why.

Let’s consider a few important points here;

Humans do Business with Humans
You need to make a connection before you attempt to do business, it's not
enough to just send endless emails...

You might be typically aiming to get your work under the nose of an Art
Director and that’s great but have you considered what his world is like and
what drives him to make those decisions on which photographer he chooses for
a shoot and why?

So, we offer our work for less, WRONG - why?

Offering the same work you see in the market now for less is just bad business
unless you are working in a ‘volume market’ that does not really care about qual-
ity, and indeed if this is the case do you really want to be in that market where
your work will seldom be appreciated and you will be in a constant battle with
others pricing you out of the market easily and starting a price war.

Be your Clients own Customer - Research

If you can demonstrate that you do actually understand your client’s needs then
you become an ‘ASSET’ not a cost. This is a complex statement to explain but
it’'s something that we will be discussing in our class together.

Getting your work out there

In our class, we are going to talk about the all important subject of approach-
ing clients and agencies with our work, looking at how we might do that, why,
and also thinking again about why having the right mindset and understanding
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our client’s needs matters so much. We will also be looking at the all important
subject of ‘Research’ and why this is really key to getting a foot hold with the
right people.

Not doing your research means that you are trying to hit a target with a blind-
fold on and just spending all your efforts firing off shots in the vain hope that
one will hit. This is very time consuming and not a way to successfully build a
business base of good strong clients.

RESEARCH RESEARCH RESEARCH

Understand their business and offer value, its not a job opportunity, you are
building a relationship for the future with your client regardless of that being
direct, or through an agency, or second party.
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The Portfolio

The important thing to understand here is that as a Commercial photographer
you are using the images in your portfolio to gain shoots, you are not actually
selling the images in the portfolio. So what does this really mean?

“There are two people in every photograph, you and the person looking at it.”
| can not tell you what to choose for your own that needs to come from you,
BUT | can tell you what to consider when doing that:

m Displays your style of work

m Your Quality of Output

m Your CONSISTENCY

m Your ability to shoot differing situations
m Your lighting ability

You put yourself into the work that you ‘create’ and the ‘you’ part comes from:
m your personality

m your style
m your influences
m your technical approach to shooting

BUT...

It’s not about you, it’s about the assets you create that can match the client’s
needs. It’s about you gaining commissions to ‘create’ new work for your client,
it’s about creating new ‘assets’ for your client.
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It is very important to understand what your client is looking for and why
because you are aiming to be hired by them to do that work.

Imagine if you hired an architect to design your house and he just ignored what
you asked him to create and did other stuff because he liked it better his way.

What do they ‘want’ and what do they ‘need’?
RESEARCH and UNDERSTAND YOUR MARKET!

In this class we will look at the purpose of the portfolio and what really counts
and why, we will also be looking at the different ways that you may or may not
choose to present that portfolio. We will look at if it really matters if it is in print
or just digital and why one of these is very very important to some potential cli-
ents operating at some of the market levels that you may be working in.

Tim Wallace (The Real Batman)

International Commercial Advertising Photographer
www.ambientlife.co.uk

Twitter - @Ambient_life
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The Joyful Photographer: Run a Successful Child Photography Business

With TRACY SWEENEY

nhotes

| bring my education experience as a classroom teacher and education pro-
fessor for many years to all my child sessions. | direct children in a way that is
natural and fun, with the goal of capturing uninhibited interactions to create
joyful portraits.

The Un-posing Approach

| begin by talking to the child, often even before talking with the parents. |
get down to the child’s eye level and start by issuing genuine warmth and
friendliness. The initial greeting is a way to establish connectivity and ensure
the child that the session will be fun and possibly exploratory, depending on
the location.
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With TRACY SWEENEY

.

When | begin photographing, | often do not let the children know that is what |
am doing. | ask the children if they want to go for a walk, or if they would like to
help me hold something, or if they would like to “hunt” for seashells, or special
rocks, leaves, etc. anything to get little ones not to think about having to perform,
but rather enjoying our time. Even the most hesitant of children, even the really
really shy ones, typically will want to discover/find/look/play if encouraged.

Tip: Ask the child questions about his/her day. If they are school aged, it is
always a nice segue to discuss their teacher, classroom, favorite activities, etc.
to open dialogue. Keep it simple.

Incorporate elements [
from the natural set-
ting. Have children
hold something: star-
fish, leaf, flower, etc.

Fast Movers

For me, photograph-
ing children means
planning and encour-
aging ways for
children to engage.
Create a storytell-
ing moment. Young
children love to skip,
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The Joyful Photographer: Run a Successful Child Photography Business

With TRACY SWEENEY

run, hop, jump, roll, and dance. Playful movement incites natural emotion that
is capture worthy. Ask the child you are photographing to jump as high as she
can, twirl as fast as she can, leap as far as she can, all the while shooting away,
engaging in the conversation, encouraging the movement, applauding the
effort. Remember, the experience needs to be playful and fun, not forced. A
child at play has the most natural expressions.

Photographing fast
moving children
creates interest but
also presents pho-
tography challeng-
es. | shoot wide
open, even when
photographing
children in motion.
| boost my shutter
to 1/500s or even
faster depending
on my natural light,
keeping my ISO as
low as | can.

When Working with Siblings
1. MOVEMENT
Create activity. Have siblings run, skip, jump, twist, twirl, hop, play

2. CONNECTIVITY
Within their movement, keep siblings connected (holding hands, hugging, tell-
ing secrets, playing with objects)
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Capture Joy and Enchantment
NARRATIVE
Craft the story. Consider the setting. Create purpose within that space.

EMOTION
Evoke genuine emotion. Be silly/playful. Sing songs. Tell jokes. Make noises.
Procure an anticipated response.

157



=< Photoshop\/\orld

a kelbvone I conference

The Joyful Photographer: Run a Successful Child Photography Business

With TRACY SWEENEY

The Power of Print
To ensure sustainability and profitability embrace the power of print/product.

3 Essential Keys to Sell More Product
1. Show enthusiasm for your product
m Discuss how you use the product.
m Emphasize the product perks.
m Make it relatable to the client.
m Specify the value of the product to the customer.
m Ex: proof box in child’s room with hospital band, badges, flower, cards, etc.

2. Express Product Feature as Benefit

The power of longevity and evolving value. The product is something that can
be enjoyed by many people (ex. wall art, coffee table book, greeting card). The
product is something that can be used over time.

3. Anticipate Client Needs

What motivates them? What needs do they have? Know what they intend to
do with their images to establish appropriate expectations and shoot with that
purpose in mind. How will the product help meet the needs?

Convert Motivations

If you want to sell more, you have to genuinely believe in the power of print.
Invest time and money to make sure your final product is packaged well. Post/
share on social media. Let future clients “see” for themselves. Build anticipa-
tion, excitement, and enthusiasm all at once.
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The products that excite you will excite your clients too.

Examples
PRODUCT SALES: Wall Art (Canvases, Print Wraps, Metals, Acrylics, Framed
Prints, Standouts), Proof Boxes, Albums/Books, Cards, USBs (Digital Images)
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Creative Practice: The Tortoise & The Hare

With JULIEANNE KOST

To access instructor provided digital downloads, visit: photoshopworld.com/ notes
downloads. The password is: PSWDDOR2018193418.
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Lightroom Mobile: Landscape & Travel Photographers

With MATT KLOSKOWSKI

To access instructor provided digital downloads, visit: photoshopworld.com/ notes
downloads. The password is: PSWDDOR2018193418.
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Everyday Portrait Retouching in Lightroom
With KRISTINA SHERK

Kristina Sherk
Photo Retoucher, Author

For the past 10 years, Kristina Sherk has been a high-end photo retoucher based out of Washington,
D.C. and is called the “picture whisperer” by some. She specializes in realistic retouching. She’s a
contributing educational author for publications like Shutter Magazine, Photoshop User Magazine
and Lightroom Magazine. She is also the author behind Photoshop Cafe’s Fashion Retouching
DVD. Her more reputable corporate clients include National Public Radio, Time Inc., XM Satellite Radio, Cotton Inc.
and most recently, Hasselblad.

Getting Started
1. Lightroom drop down menu > Catalog settings
a. Metadata tab
i. Uncheck automatically write changes into XMP
1. Takes up too much processing power and slows down brush speed
2. Just remember to select all images and manually save meta-
data (cmd/ctrl + S) changes before exiting Lightroom
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b. File Handling tab
i. Camera Raw Cache Settings
1. Default = 10GB
2. Increase that maximum size to somewhere between 30-50 GB
3. Helps Lightroom run faster, purge cache
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2. History
a. Anytime you make an adjustment to an
image, it logs it as a history state so you can
move backwards
b. That really slows down Lightroom though
c. If you notice the program being sluggish,
click “clear all” on one image
i. This does not “flatten” the image, it just
forgets the steps while keeping the edit-
ing non destructive

Tools
1. Spot healing brush = “Q”
a. Shift + T toggles between clone/heal
2. Adjustment brush = “K”
a. Two brush options
i. Keep brush A large, 100% feather, low flow
ii. Brush B small, .01 radius, O feather, 90% flow
iii. Switch between brushes with “/”
iv. With mask selected, holding down
option/alt allows you to erase the effect
in certain areas
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b. Clicking on the pin point will allow you to edit them
c. “H” = hides pinpoints
d. “O” = show and hides mask overlay

e. Bracket keys make brush sizes bigger and smaller
f. Shift + bracket keys make the feather larger and smaller
g. Number keys change the flow (1=10%, 2=20%, etc.)
h. The “lightswitch” at the bottom of the adjustment
brush panel toggles on and off the effect of that
particular adjustment brush
3. “/” = Preview before and after of the overall image

Blemishes
1. Clone/Healing brush tool
a. “Q”
b. Cloning takes the texture and color from the area
you sample
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c. Healing takes the texture from the sample and the color from where
the spot is being applied

g

d. Use the healing brush to get rid of blemishes

e. If you don’t like the area it first pulls information from, use the backs-
lash key on your keyboard and Lightroom will look for other areas to
sample from. You can also click the sample point and drag/drop to
the best area to sample texture from

f. Return/Enter key accepts the change

2. Under eye area

a. Use healing brush tool

b. Draw a line over the whole under eye, drag the sample point down
to right under- '
neath that line

c. Drag down
opacity to make
it look more real-
istic and natural

d. Backslash key =
before and after,
H key hides the
access points

Creating and Saving Localized Adjustment Brushes
1. Adjustment Brush = K key
2. If you do something in Lightroom more than 5 times, you should create an
adjustment brush or preset that does it for you
a. Like actions in Photoshop
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3. Once you have the settings for the brush you want to create, click the
Effect drop down menu and select “Save Current Settings As New Preset”

Nl
L

4. When you make a change to the original brush, you can update the preset
from the bottom of the drop down menu

Eyes
1. Enhance Iris
a. Increase exposure, increase contrast, increase highlights, bring shad-
ows up, add sharpness, increase saturation, increase clarity, increase
temperature, decrease tint
b. Paint brush around iris
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c. Brush settings:
d. Add color:

2. Eye whites
a. Decrease temperature and tint, increase
exposure, increase shadows, decrease clar-
ity to soften veins, decrease saturation,
decrease sharpness, increase noise reduction
b. Brush settings:
. 30% opacity
d. Paint in with 30% opacity mostly around
the iris, avoid brightening corners too
much because that can look fake
e. Always hit return before you start a new
adjustment

(@]

3. Brows

a. Brush Settings:

b. Using a small brush with .1 pixel radius
brush, no feather, high flow and paint zig-
zags to mimic the look of eyebrow hairs

c. Click the disclosure arrow up and bring
down the amount of effect applied.
Disclosure arrow is the small black down-
ward facing arrow in upper right corner.
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d. If using a mouse, use a larger brush with more
feather and low flow with broad strokes to overall
shape the eyebrows

Skin
1. Skin Smoothing

a. The way you need to smooth skin is
different based on the color of skin

b. Skin High Light - brush settings:

c. Keep overlay visible while painting
in this effect so you can avoid areas
where you don’t want the effect
showing

d. Avoid areas near high contrast - near hair, eyebrows; telltale sign of
too much retouching when creases are super smooth
e. If you see a spinning beach ball (computer slowing down) clear the
history
i. Localized adjustment brushes are nondestructive, so if you clear
the history it will not flatten the image but it will give more pro-
cessing power
f. Option/Alt key = Erase
g. If your adjustment makes the skin look too smooth..
i. Select the pinpoint and right click to duplicate the mask, then
reset the adjustment brush
ii. Drag the new pinpoint slightly to the side so you can tell them apart
iii. Double click effect button to reset the adjustments
iv. Decrease the noise reduction slider to bring back detail and
increase the sharpness
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Dodge and Burn
1. Light shaping - great for natural light shots to even out lighting
2. Brightening/dodging areas enhances and brings them closer to camera, dark-
ening/burning pushes areas diminishes and farther away from the camera
3. Dodge (Lighten) and Burn (Darken) presets are already in Lightroom
a. Edit dodge preset - increase exposure to 55
i. Paint in with low flow
ii. Small brush for detail areas, large brush for overall highlighting
b. Burning - use preset
i. Broad stokes to darken certain areas and shape face
ii. Add a little light orange color with 20% saturation to keep color
consistent between highlight and shadow areas

7

Mouth/Teeth
1. Lips

a. Easily add color with these steps

b. Decrease saturation and add red color
(75% saturation) to mimic lipstick

c. Brush settings:

d. Avoid highlight areas because they
would naturally be light, just paint the
color around the lip color areas

e. Use exposure slider to lighten/darken
the lip color

f. These steps can be repeated to add color
anywhere - eyes, lips, cheeks

2. Teeth
a. Decrease temperature, increase exposure, bring up shadows,
decrease saturation, add color overlay
b. Brush Settings:
c. In this instance, we want to choose the complimentary color to yel-
low which is blue (11% saturation)
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d. Brush Settings:
e. Only time auto-mask is beneficial
i. Keep the plus sign on the teeth, don’t let it extend onto the gums
or they will be included in the mask

f. Brush Settings:

g. Click to access the
pinpoint, close the
disclosure arrow,
and decrease the
effect of the teeth
whitening to make it
nice and natural

Men
1. Men especially need to be protected from over smooth skin
2. Use low skin smoothing to protect more of the detail
a. Avoid chin and lower jaw if there is a 5 o’clock shadow or any facial
hair in general
b. Like before, right click and duplicate mask and drag pin a little to
the side
c. With the second mask still activated, double click effect to reset
that tool
d. Add a lot of sharpening and decrease noise reduction
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e. Brush Settings:
f. Goal = skin smoothing while protecting the detail of
the skin
3. To deal with the 5 o’clock shadow:
a. New adjustment brush - double click on effect to
reset all sliders
b. Decrease de-haze slider
i. Bringing it down will make it hazier
ii. Will soften the stubble
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Synching Adjustments Over Multiple Images

1. Once you make the desired
adjustments on an image, you
can sync the adjustment by
going to the library module,
selecting the images you want
to copy the settings to, and
selecting “Sync Settings” in the
quick develop tab. Make sure
the localized adjustment boxes
+ process version are checked

2. If the face is in a slightly different position in an image, you can click the
adjustment pinpoints and drag them into the correct position on the face
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With SERGE RAMELLI

To access instructor provided digital downloads, visit: photoshopworld.com/ notes
downloads. The password is: PSWDDOR2018193418.
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Lightroom and the Cloud: The Lightroom CC Workflow

With ROB SYLVAN

To access instructor provided digital downloads, visit: photoshopworld.com/ nhotes
downloads. The password is: PSWDDOR2018193418.
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Black & White & Yesterday

With SERGE RAMELLI

To access instructor provided digital downloads, visit: photoshopworld.com/ nhotes
downloads. The password is: PSWDDOR2018193418.
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With ROB SYLVAN

To access instructor provided digital downloads, visit: photoshopworld.com/ notes
downloads. The password is: PSWDDOR2018193418.
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